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UNIT 1 

Introduction 

A computer is a general purpose device that can be programmed to carry out a set of arithmetic or 

logical operations automatically.  

A computer is an electronic device that manipulates information, or data. It has the ability 

to store, retrieve, and process data. You can use a computer to type documents, send email, and 

browse the Web. You can also use it to handle spreadsheets, accounting, database management, 

presentations, games, and more. 

In World War II, mechanical analog computers were used for specialized military applications. 

During this time the first electronic digital computers were developed. Computer was developed by 

CHARLES BABBAGE. He is also known as Father of computers. 

All types of computers consist of two basic parts: 

 Hardware is any part of your computer that has a physical structure (Tangible), such as 

the computer monitor or keyboard. 

 

 Software is any set of instructions that tells the hardware what to do. It is what guides the 

hardware and tells it how to accomplish each task. Some examples of software include web 

browsers, games, and word processors such as Microsoft Word. 

 

 

   

  

 

 

 

 

 

 

Organization of a Computer 

Computer can also be defined in terms of functions it can perform. A computer can 

i) Accept data,  

ii) Store data,  

iii) Process data as desired,  

iv) Retrieve the stored data as and when required and  

v) Print the result in desired format. 

 

Characteristics of computer:- 

 Speed 

 Accuracy 

 Power of Remembering 

 Diligence 

 Versatility 

 No IQ 

 No Feeling 

 Storage 

Output Unit          Processing Unit      INPUT

  

     Memory 
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Block diagram of Computer:- 

 

 
 

 

1. Input: this is the process of entering data and programs into the computer system. 

2. Control Unit (CU): The process of input, output, Control Unit (CU): The process of input, 

output, processing and storage is performed under the supervision of a unit called 'Control 

Unit'. It decides when to start receiving data, when to stop it, where to store data, etc. It takes 

care of step -by-step processing of all operations inside the computer. 

3. Memory Unit: Computer is used to store data and instructions. 

4. Arithmetic Logic Unit (ALU): The major operations performed by the ALU are addition, 

subtraction, multiplication, division, logic and comparison. 

5. Output: This is the process of producing results from the data for getting useful information. 

The ALU and the CU of a computer system are jointly known as the central processing unit 

(CPU). You may call CPU as the brain of any computer system. 

 

Basic application of Computer 

 Word Processing 

 Internet 

 Digital video or audio composition 

 Desktop publishing 

 Computers in Medicine 

 Mathematical Calculations 

 Banks 

 Travel 

 Telecommunications 

 Defense 

 E-Learning 

 Business 
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A motherboard is the main printed circuit board (PCB) found in general 

purpose microcomputers and other expandable systems. It holds and allows communication between 

many of the crucial electronic components of a system, such as the central processing unit (CPU) 

and memory, and provides connectors for other peripherals. A motherboard usually contains 

significant sub-systems such as the central processor, the chipset's input/output and memory 

controllers, interface connectors, and other components integrated for general purpose use. 

Motherboard specifically refers to a PCB with expansion capability and as the name suggests, this 

board is often referred to as the "mother" of all components attached to it, which often 

include peripherals, interface cards, and sound cards, video cards, network cards, hard drives, or 

other custom components. 

Computer Hardware: 

In simple terms we can say, computer parts that have tangible property are comes under computer 

hardware categories. Computer hardware is the physical parts or components of a computer.  This is 

also sometime called the machinery or the equipment of the computer. 

 

Computer Software:  

Computer software is instructions that can be stored and run by hardware. Software is any set of 

machine-readable instructions that directs a computer's processor to perform specific operations.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 Insurance 

 Banking 

 Business 

 Education 

 Marketing 

 Health Care 

 Engineering Design 

 Military 

 Communication 

 Government Applications 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The various applications of Computers:- 
 

Computer 
Software 

Hardware 

https://en.wikipedia.org/wiki/Printed_circuit_board
https://en.wikipedia.org/wiki/Microcomputer
https://en.wikipedia.org/wiki/Central_processing_unit
https://en.wikipedia.org/wiki/Computer_memory
https://en.wikipedia.org/wiki/Peripherals
https://en.wikipedia.org/wiki/Printed_circuit_board
https://en.wikipedia.org/wiki/Peripheral
https://en.wikipedia.org/wiki/Sound_card
https://en.wikipedia.org/wiki/Video_card
https://en.wikipedia.org/wiki/Network_card
https://en.wikipedia.org/wiki/Hard_drive
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Input devices 

 

 

 

 

Input devices 

 

An input device is an electromechanical device as it utilizes both electronic and mechanical power. 

It aims in receiving data from external world. The input devices are responsible for converting data 

into a form that is understood by the computer. An input device is a peripheral device that converts 

symbols that people understand into bits that computers can process 

  

Basic working of input devices:- 

 

 Accept the data. 

 Convert it into the machine understandable form. 

 

Computer Hardware 
- 

Input devices 
Output devices 
 

Storage device Processor 
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Different Types of input devices:-  

 

 Keyboard 

 Mouse 

 Joystick 

 Light pen 

 Track Ball 

 Scanner 

 Graphic Tablet 

 Microphone 

 Magnetic Ink Card Reader (MICR) 

 Optical Character Reader (OCR) 

 Bar Code Reader 

 Optical Mark Reader 

 

 

 

Keyboard 

Keyboard is one of the most commonly used input devices to input the date into the computer. It is 

like the traditional typewriter, although there are some additional keys provided for performing some 

additional functions. Keyboards are of two sizes 84 keys or 101/102 keys, but now 104 keys or 108 

keys. 

 

 Keyboard is an input device used to enter data in to computer by pressing one key at one 

time. 

 It has its own processor and circuitry that carries information to the processor. 

 When you press a key, it presses a switch, completing the circuit and allowing a tiny amount 

of current to flow through. 

 It tells the processor the position of each key what each keystroke or combination of 

keystrokes represents. 

 
 Despite the development of alternative input devices, such as mouse, touch screen, light 

pen, the keyboard remains the most commonly used and most versatile device used for direct 

(human) input into computers. 

 One factor determining the size of a keyboard is the presence of duplicate keys, such as a 

separate numeric keyboard, for convenience. 

  Another factor determining the size of a keyboard is the size and spacing of the keys. 

 

Generally the keyboards contain the following keys, they are:- 
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 Alphabets 

 Arithmetic operators such as +, -, *, / 

 Numeric digits 0–9 

 Cursor arrow keys 

 Navigation keys such as Home, End, PgUp, PgDown, etc. 

 Num Lock button, used to enable or disable the numeric pad.  

 Enter key 

 

The following are the different layouts of the keyboards, they are as follows 

 QWERTY 

 QWERTZ 

 AZERTY  

 DVORAK 

 

Mouse: 

The mouse is used to point to a particular place on the screen and select to perform one or more 

action. The pointing device may point to the menu, commands, size windows, starts programs etc. 

The most conventional kind of mouse has two buttons on top: the left one being used most frequently 

then right one. A mouse is a pointing device that functions by detecting 2D motion relative to its 

supporting surface. The mouse's motion typically translates into the motion of a pointer on a display, 

which allows for fine control of a graphical user interface 

 

Mouse Actions 

 Left Click  

 Double Click  

 Right Click  

 Drag and Drop 

 

Types of mouse:- 

 

 Mechanical mouse: Houses a hard rubber ball that rolls as the mouse is moved. Sensors 

inside the mouse body detect the movement and translate it into information that the 

computer interprets. 

 Optical mouse: Uses an LED sensor to detect tabletop movement and then sends off that 

information to the computer for merry munching. 

 Cordless 3-D mouse: This kind of mouse can be pointed at the computer screen like a TV 

remote 

 Wireless Mouse: Wireless mouse works via radio frequencies commonly referred to as RF. 

RF wireless mouse requires two components to work properly – a radio transmitter and a 

radio receiver. 

RF Transmitter: A radio frequency (RF) transmitter is usually integrated inside the mouse. 

The mouse records its movements and buttons that are clicked and then sends this 

information via radio signals to the receiver. 

RF Receiver: The radio frequency (RF) receiver usually connects to the computer‘s 

peripheral mouse input. It receives these RF signals, decodes them, and then sends these 

signals directly to the computer as normal. 
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                 Mechanical Mouse     Wireless Mouse 

 

Track ball: 

This is also a pointing device. Track ball is an input device that is mostly used in notebook or laptop 

computer, instead of a mouse. This is a ball, which is half inserted and 

by moving fingers on ball, pointer can be moved. Since the whole 

device is not moved, a track ball requires less space than a mouse. A 

track ball comes in various shapes like a ball, a button and a square.  

 

Compared with a mouse, a trackball has no limits on effective travel; 

at times, a mouse can reach an edge of its working area while the 

operator still wishes to move the screen pointer farther. With a 

trackball, the operator just continues rolling, whereas a mouse would 

have to be lifted and re-positioned. 

 

 

Joystick:- 

The joystick is handheld stick. This stick can rotate about one end 

transmitting its angle to the computer in two or three dimensions. It 

typically has a button on top that is used to select the option pointed by the 

cursor.  

Joysticks are often used to control video games, and usually have one or 

more push-buttons whose state can also be read by the computer. 

 

Elements in a Joystick 

 Stick  

 Base 

 Trigger 

 Extra button 

 Autofire 

switch 

 Throttle 

 Hat switch 

 Suction cup 

 

 

Digitizing Tablet: 
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An input device that permits drawing of images and graphics is called a digitizing tablet. They give 

feeling of drawing images with pencil and paper. The graphics tablet has two major parts that are:- 

 A flat surface on which the image is drawn.  

 Stylus that helps in drawing. 

 

 

Scanners 

An input device capable to read text or illustrations printed on a paper and 

interpret it in a form that can be used by a computer is known as a 

scanner. It converts the document image into digital form so that it can be 

fed into the computer. Capturing information like this reduces the 

possibility of errors typically experienced during large data entry. 

 

Digital Camera 

A digital camera can store many more pictures than an ordinary camera. Pictures taken using a 

digital camera are stored inside its memory and can be transferred to a computer by connecting the 

camera to it. A digital camera takes pictures by converting the light passing through the lens at the 

front into a digital image. 

There are several categories in which the cameras can be classified:- 

 Video camera  

 Professional video cameras 

 Camcorders used by amateurs. 

 webcams  

 Digital camera 

 Live-preview digital cameras 

 Compact digital cameras 

 Bridge cameras 

 

 

 

 

 

Magnetic Ink Character Recognition: 

 

 
MICR is also an input device is commonly used in banks because of a large number of cheques to be 

processed. The bank's code number and cheque number are printed on the cheques with a special 

type of ink that contains particles of magnetic material that are machine readable. This reading 

process is called Magnetic Ink Character Recognition (MICR).  
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Magnetic Ink Character Recognition is a character recognition system that uses special ink and 

characters. When a document that contains this ink needs to be read, it passes through a machine, 

which magnetizes the ink and then translates the magnetic information into characters. 

 

MICR technology is used by banks. Numbers and characters found on the bottom of checks (usually 

containing the check number, sort number, and account number) are printed using Magnetic Ink. To 

print Magnetic Ink need, you need a laser printer that accepts MICR toner. 

MICR provides a secure, high-speed method of scanning and processing information. 

 

Optical character Reader:-  
Optical character Reader is an input device that is use to read a printed text. The OCR 

scans text optically character by character, converts them into a computer readable code 

and stores the text on the system memory.  

 

Optical Mark Reader:- 

Optical mark reader is also known as optical mark recognition that is same as the scanner which 

reads on specific areas of the page. Thus OMR can be defined as the process of scanning paper-based 

documents and identify data or marks in a location defined previously. 

It is specially used for checking the answer sheets of examinations having multiple choice questions. 

 

Bar Code Reader:- 

An electronic device used to read barcodes printed on various surfaces is called 

barcode reader. It is also known as barcode scanner. Bar Code Reader scans a bar 

code image, converts it into an alphanumeric value, which is then fed to the 

computer to which bar code reader is connected. 

Bar coded data is generally used in labeling goods, numbering the books, etc. It 

may be a hand-held scanner or may be embedded in a stationary scanner. 

 

Voice Recognition System:- 

Voice recognition systems are alternatively known as voice data entry or audio data entry terminals. 

This method of input enables a programmer to instruct the computer with spoken words instead of a 

written program 

 

 

Light Pen:- 

Light pen is also an input device used as pointing device, 

which is similar to a pen. It is used to select a displayed 

menu item or draw pictures on the monitor screen. It 

consists of a photocell and an optical system placed in a 

small tube. 

When light pen's tip is moved over the monitor screen and 

pen button is pressed, its photocell sensing element detects 

the screen location and sends the corresponding signal to 

the CPU. 

 A light pen is a computer input device used in conjunction with a computer's CRT display. 
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 It allows the user to point to displayed objects or draw on the screen in a similar way to 

a touch screen but with greater positional accuracy. 

 A light pen detects a change of brightness of nearby screen pixels when scanned by cathode 

ray tube electron beam and communicates the timing of this event to the computer. 

 Because the user is required to hold his arm in front of the screen for long period of time, the 

light pen fell out of use as a general purpose input device. 

Touch screen:- 

An input device that permits users to operate a PC by simply touching the display screen is called a 

touch screen. The touch screen is as easy to use as trackballs or touchpad‘s. 

Three major components form a basic touch screen they are as follows:- 

 Touch sensor 

 Controller 

 Software driver 
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Output Devices 

 

 

An output is an electromechanical device that receives output from a computer in binary coded form 

and converts it into human understandable form and transmits to the user. An output device is 

any peripheral that receives data from a computer, usually for display, projection, or physical 

reproduction. 

 Monitor / Visual Display Unit 

 Printer 

 Plotter 

 Speaker 

 

Monitor: 

Monitor is the most common and the most popular output device.  It forms images from tiny dots, 

called pixels that are arranged in a rectangular form. The sharpness of the image depends upon the 

number of the pixels. 

 

There are two types of viewing screen used for monitors: 

 

 Cathode-Ray Tube (CRT):  

The CRT display is made up of small picture elements called pixels. The smaller 

the pixels, the better the image clarity, or resolution. It takes more than one 

illuminated pixel to form whole character, such as the letter ‗e‘ in the word help. 

 There are some disadvantages of CRT: 

 Large in Size 

 High power consumption 

 

 Flat-Panel Display Monitor 

The flat-panel display refers to a class of video devices that have reduced volume, weight and 

power requirement in comparison to the CRT. You can hang them on walls or wear them on your 

wrists. Current uses of flat-panel displays include calculators, 

video games, monitors, laptop computer, graphics display. 

 

The flat-panel display is divided into two categories: 

 Emissive Displays - The emissive displays are devices 

that convert electrical energy into light. Example are plasma 

panel and LED(Light-Emitting Diodes). 

 Non-Emissive Displays - The Non-emissive displays 

use optical effects to convert sunlight or light from some other 

source into graphics patterns. Example is LCD(Liquid-Crystal 

Device) 

 

 

 

Classification- Based on Signals: 

 Digital Monitor 

 Analog Monitor 
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Classification- Based on Picture Quality 

 VGA 

 SVGA 

 XGA 

 

Printer:- 

A printer is an output device that is used in a computer to print alphanumeric characters on papers. It 

converts the electronic signals from the computer into human readable form or hardcopy to produce 

a print out of the result of data processed in the computers. 

Printers are broadly classified in to two categories:- 

 

Impact printers: 

An impact printer has mechanisms resembling those of a typewriter. It forms characters or images 

by striking a mechanism such as a print hammer or wheel against an inked ribbon, leaving an 

image on paper. 

 

 Character Printer:-  

Impact printers are dying out; however, you may still come in contact with a dot-matrix printer. 

A dot-matrix printer contains a print head of small pins that strike an inked ribbon, forming 

characters or images. Print heads are available with 9, 18, or 24 pins; the 24-pin head offers 

the best print quality. 

 Dot-matrix printers permit a choice between output of draft quality; a coarser-looking 72 dots 

per inch vertically, which may be acceptable for drafts of papers and reports, and near-letter-

quality, a crisper-looking 144 dots per inch vertically, which is more suitable for a finished 

product to be shown to other people. 

 

 Dot-matrix printers print about 40-300 characters per second (cps) and can print some 

graphics, although the reproduction quality is poor. Color ribbons are available for limited 

use of color. Dot-matrix printers are noisy, inexpensive, and they can print through multipart 

forms, creating several copies of a page at the same time,  

 

 Dot-Matrix Printer 

 Daisy-Wheel Printer 

 Line printer 

 Drum Printer 

 Chain Printer 

 Non-Impact printers 

  Ink-Jet Printer 

   Laser Printer 

 

Plotter:- 

A plotter is a vector graphics printing device that connects to a computer. It draws pictures on paper 

based on commands from computer. A plotter is a very versatile tool. 

 

Types of plotters:- 

 Drum plotter 
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 Flat-Bed plotter 

 

Sound Cards:- 

Sound cards are a important part of computer, without sound cards you will have no music, no 

effects and no voices. Sound card is also referred as a sound board or an audio card, a sound 

card is an expansion card or integrated circuit that provides a computer with the ability to produce 

sounds that can be heard by the user either over speakers or headphones.  

Sound card connections are as follows:- 

 Digital out 

 Sound in or line in 

 Microphone or Mic 

 Sound out or line out 

 Fire wire 

 MIDI or Joystick 

 

Speakers:- 

 

 A hardware device that is connected to a computer's sound card that outputs sounds generated by 

the computer is referred as speaker. Speakers are rated in Frequency response, Total Harmonic 

Distortion, and Watts.  

 

Storage:- 

Computer data storage is often known as storage or memory refers to computer components and 

recording media that retain digital data used for computing for some interval of time. A memory is 

just like a human brain. It is used to store data and instructions. Computer memory is the storage 

space in computer where data is to be processed and instructions required for processing are stored. 

Memory is primarily of two types: 

 Primary Memory/Main Memory 

 Secondary Memory 

 

Primary memory:- 

Primary memory holds only those data and instructions on which computer is currently working. It 

has limited capacity and data gets lost when power is switched off. It is generally made up of 

semiconductor device. These memories are not as fast as registers. The data and instructions required 

to be processed earlier reside in main memory. Primary memory is divided into two categories they 

are as follows:- 

 RAM 

 ROM. 

 

RAM:- 

Full form of  RAM random access memory (RAM). A RAM constitutes 

the internal memory of the CPU for storing data, program and program 

result. It is read/write memory. Since access time in RAM is independent 

of the address to the word that is, each storage location inside the 

memory is as easy to reach as other location & takes the same amount of 

time 

RAM is volatile, i.e., data stored in it is lost when we there is a power 
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failure. Hence, a backup uninterruptible power system (UPS) is often used with computers. RAM is 

small, both in terms of its physical size and in the amount of data it can hold. 

There are two types of RAM they are as follows:- 

 Static RAM (SRAM)  

 Dynamic RAM (DRAM) 

Static RAM (SRAM) 

 

 The word static indicates that the memory retains its contents as long as power remains 

applied.  

 Data is lost when the power gets down due to volatile nature.  

 SRAM chips use a matrix of 6-transistors and no capacitors.  

 Transistors do not require power to prevent leakage, so SRAM need not have to be refreshed 

on a regular basis. 

 Because of the extra space in the matrix, SRAM uses more chips than DRAM for the same 

amount of storage space, thus making the manufacturing costs higher. 

 Static RAM is used as cache memory needs to be very fast and small. 

 

Characteristic of the Static RAM 

 It has long data lifetime 

 There is no need to refresh 

 Faster 

 Used as cache memory 

 Large size 

 Expensive 

 High power consumption 

 

Dynamic RAM (DRAM) 

 DRAM must be continually refreshed in order to maintain the data.  

 This is done by placing the memory on a refresh circuit that rewrites the data several hundred 

times per second. 

 DRAM is used for most system memory because it is cheap and small.  

 All DRAMs are made up of memory cells.  

 These cells are composed of one capacitor and one transistor. 

 

Characteristic of the Dynamic RAM 

 It has short data lifetime 

 Need to refresh continuously 

 Slower as compared to SRAM 

 Used as RAM 

 lesser in size 

 Less expensive 

 Less power consumption 

 

ROM:- 

ROM is Read Only Memory. ROM are the memories on which it is 

not possible to write the data when they are online to the computer. 

They can only be read. It is a permanent in built in the computer at 

the time of its production. It is also known as firmware. It stores 

the set of instructions permanently which instructs the computer 
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how to work. The ROM can be used in storing micro programs, system programs, subroutines. 

Types of ROM are as follows:- 

 PROM 

 EPROM 

 EEPROM 

 

MROM (Masked ROM) 

 The very first ROMs were hard-wired devices that contained a pre-programmed set of data or 

instructions.  

 These kinds of ROMs are known as masked ROMs.  

 It is inexpensive ROM. 

PROM (Programmable Read only Memory) 

 PROM is read-only memory that can be modified only once by a user.  

 The user buys a blank PROM and enters the desired contents using a PROM programmer.  

 Inside the PROM chip there are small fuses which are burnt open during programming.  

 It can be programmed only once . 

 It is not erasable. 

 

EPROM(Erasable and Programmable Read Only Memory) 

 The EPROM can be erased by exposing it to ultra-violet light for duration of up to 40 

minutes.  

 During programming an electrical charge is trapped in an insulated gate region.  

 The charge is retained for more than ten years because the charge has no leakage path.  

 For erasing this charge, ultra-violet light is passed through a quartz crystal window (lid). 

 This exposure to ultra-violet light dissipates the charge.  

 During normal use the quartz lid is sealed with a sticker. 

 

EEPROM(Electrically Erasable and Programmable Read Only Memory) 

 The EEPROM is programmed and erased electrically.  

 It can be erased and reprogrammed about ten thousand times.  

 Both erasing and programming take about 4 to 10 ms (milli second).  

 In EEPROM, any location can be selectively erased and programmed. 

 EEPROMs can be erased one byte at a time, rather than erasing the entire chip. 

 Hence, the process of re-programming is flexible but slow. 

 

UVEPROM(Ultra Violet Erasable and Programmable Read Only Memory) 

 The UVEPROM is programmed and erased using ultra Violet rays.  

 It can be erased and reprogrammed about ten thousand times.  

 Both erasing and programming take about 4 to 10 ms (milli second).  

 

Advantages of ROM 

 Non-volatile in nature 

 These cannot be accidentally changed 

 Cheaper than RAMs 

 Easy to test 

 More Reliable than RAMs 

 These are static and do not require refreshing 

 Its contents are always known and can be verified 
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Secondary memory:- 

Secondary memory is also known as external memory or non-volatile. It is slower than primary 

memory. These are used for storing Data/Information permanently the data one stored will not be 

erased as the power is switched off. CPU directly does not access these memories, instead they are 

accessed via input-output routines. Contents of secondary memories are first transferred to main 

memory and then CPU can access it.  

Types of secondary memory are as follows:- 

 Magnetic tapes 

 Magnetic disk 

 

Magnetic tapes:- 

Magnetic tape is the most commonly used device for storing large data. It is sequential access 

device. Magnetic tape is a strip or ribbon of plastic which is coated with Ferro magnetic oxides. It is 

generally 80-2400 feet long and ½ inch wide, in size. 

 

Magnetic Disk:- 

A magnetic disk is a circular plate constructed of metal or plastic coated with magnetized material. 

Both sides of the disk are used and several disks may be stacked on one spindle with read/write 

heads available on each surface. Bits are stored in magnetized surface in spots along concentric 

circles called tracks. Tracks are commonly divided into sections called sectors. Disk that are 

permanently attached and cannot removed by occasional user are called hard disks. A disk drive with 

removable disks is called a floppy disk drive. 

 

Types of magnetic disk:- 

 Hard disk 

 Floppy disk 

 Compact disk 

 Video CD 

 DVD 

Floppy Disk 

The floppy disk gets its name from the fact that it is made out of a flexible plastic material. The 

plastic base is coated with an iron-oxide recording substance that's similar to the material applied to 

the plastic ribbon of a magnetic tape. Data are recorded as tiny invisible magnetic spots on this 

coating.  

CD-ROM 

The CD-ROM (Compact Disk Read Only Memory) is a direct extension of audio CD. CD-ROM 

players are more rugged and have error correction facility. This ensures proper data transfer from 

CD-ROM to the RAM of the computer. CD-ROM is written using a CD writer. Information is 

retrieved from a CD-ROM using a low power laser, which ingenerate in an on optical disk drive 

unit.  

Hard Disk 

The disk described so far is the type of disks which can be removed from the disk drive and carried 

from place to place. Some disks however, are built into the computer or a special disk drive.. Hard 

disks can store anywhere from 20 MB to more than 40GB. Hard disks are also from 10 to 100 times 

faster than floppy disk. 
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USB drive (1) An external hard disk drive or optical disc drive that plugs into the USB port. 

portable hard drive. (2) A solid state storage module that plugs into the computer's USB port. Using 

flash memory chips that hold up to one terabyte of data, the solid state USB drive emulates a hard 

disk. 

A USB flash drive -- also known as a USB stick, USB thumb drive or pen drive -- is a plug-and-play 

portable storage device that uses flash memory and is lightweight enough to attach to a keychain. A 

USB flash drive can be used in place of a compact disc. 

 

Cache Memory 

Cache memory is faster than the main memory. The cache memories although are fast yet are very 

expensive memories and are used in only small size. Thus, small cache memories are intended to 

provide fast speed of memory retrieval without sacrificing the size of memory. Cache memory stores 

a copy of the instructions and data to be immediately used of main memory. The memory reads or 

writes operation is first checked with cache memory and if the desired location data is available in 

cache memory then used by the CPU directly. 

 

 

Other Memories:- 

 Flash memory 

 Virtual memory 

 Cache Memory 

 

Software 

Software is a set of program which performs desired task. Software runs on hardware. Software is a 

sequence of instructions written to solve a particular problem. 

There are two types of software‘s: 

 System Software 

 Application Software 

 

System Software:- 

System Software performs the basic functions necessary to start and operate a computer. It refers to 

all programs that make computer work. It controls and monitors the various resources of a computer 

such as processor, input-output devices and communication links. Example : - Operating System and 

Compiler  

 

System software is divided into three categories:- 

 System management software 

 System support software 

 System development software 

 

Application Software:- 

Application software refers to the programs which help the computer to work effectively for specific 

applications. Example Ms- Office , Tally , Adobe etc. 

Application software is of two types:- 

 General purpose program 

 Application specific program 

Other software‘s are as follows:- 
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 Utility software 

 utility software are those software that is used for system utilization . 

like antivirus , window media player etc. 

Virus :-  

A computer virus is a program or piece of code that is loaded onto your computer without you 

knowledge and runs against your wishes. All computer virus are man made. 

A few prominent virus are Michelangelo, dishwasher, C-brain , macmag , nenusalem , columbus  

etc. 

 

Antivirus : - a utility software that searches a hard disk for viruses and removes any that are found. 

Most antivirus programs include an auto update feature that enables the program to download 

profiles of nes virus so that it can check for the new viruses as soon as they are discovered. 

Some popular antivirus are NPAV, Quick heal ,Avast and Mac fee etc. 

 

 

Compiler - Compiler is a system program which translates a high-level language program into 

machine language program is called a compiler. Compiler also checks error of the program to be 

executed. 

 

Features of the compiler:  

Compiler is more powerful than assembler. 

 

Limitation of the compiler: 

 Take longer time to produce result. 

 It occupies more memory space. 

 Low speed and low efficiency of memory utilization. 

 

                                           
 

Interpreter - It is also a translator which translates a high-level language program into object code, 

statement wise. It doesn‘t translate the entire program at a time. It takes up one statement of a high-

level language program at a time, translates it and then executes it and then takes up the next 

statement and repeats the whole process till end. 

Features of the Interpreter: 

 Interpreter is cheaper than compiler. 

 It occupies less memory space. 

 

Limitations of the Interpreter: 

 Slower than compiler. 

 Suitable only for small programs. 
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The difference between an interpreter and a compiler is given below: 

Interpreter Compiler 

Translates program one statement at a time. 
Scans the entire program and translates it as a 

whole into machine code. 

It takes less amount of time to analyze the 

source code but the overall execution time is 

slower. 

It takes large amount of time to analyze the 

source code but the overall execution time is 

comparatively faster. 

No intermediate object code is generated, 

hence are memory efficient. 

Generates intermediate object code which 

further requires linking, hence requires more 

memory. 

Continues translating the program until the 

first error is met, in which case it stops. Hence 

debugging is easy. 

It generates the error message only after 

scanning the whole program. Hence debugging 

is comparatively hard. 

Programming language like Python, Ruby use 

interpreters. 

Programming language like C, C++ use 

compilers. 
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Linker: In high level languages, some built in header files or libraries are stored. These libraries are 

predefined and these contain basic functions which are essential for executing the program. These 

functions are linked to the libraries by a program called Linker.  

If linker does not find a library of a function then it informs to compiler and then compiler generates 

an error. The compiler automatically invokes the linker as the last step in compiling a program. 

Not built in libraries, it also links the user defined functions to the user defined libraries. Usually a 

longer program is divided into smaller subprograms called modules. And these modules must be 

combined to execute the program. The process of combining the modules is done by the linker. 

 

Loader: Loader is a program that loads machine codes of a program into the system 

memory. In Computing, a loader is the part of an Operating System that is responsible for loading 

programs. It is one of the essential stages in the process of starting a program. Because it places 

programs into memory and prepares them for execution. Loading a program involves reading the 

contents of executable file into memory.  Once loading is complete, the operating system starts the 

program by passing control to the loaded program code. All operating systems that support program 

loading have loaders. In many operating systems the loader is permanently resident in memory.  

 
 

 

Languages of Computer:- 

In order to communicate with the computer user also needs to have a language that should be 

understood by the computer. For this purpose, different languages are developed for performing 

different types of work on the computer. Basically, There are three types of computer languages they 

are as follows:- 

 Low level language 

 Assembly level language 

 High level language 

 

Low level language:- 

Low level language is also known as Machine level language. The low level 

language is directly understood by the computer. in other words, the binary 

language is machine language(0s and 1s). any instruction given in the machine 

language has two parts:- 

 OPCODE 
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 OPERAND 

 

Assembly level language:- 

The major drawback of machine language lead to the introduction of a new language called 

assembly level language. A program written in symbolic language is called an assembly code or a 

symbolic program. Assembler translates the assembly code into machine code, it also ―assembles‖ 

the machine code into the main memory of the computer and makes it ready for execution.  

 

 

 

High Level Language:- 

To overcome the difficulties of low level language such as machine dependency, difficult to 

understand etc. high level languages are classified into two types- general and specific purpose high 

level language. 

                                    
 

 

 

Data compression 

Data compression is encoding of information using fewer bits than the original representation. The 

process of reducing the size of a data file is referred to as data compression  

Lossy: Lossy compression reduces bits by removing unnecessary or less important information. 

Lossless: Lossless compression reduces bits by identifying and eliminating statistical redundancy. 

No information is lost in lossless compression.  

Uncompressing (or decompressing) is the act of expanding a compression file back into its original 

form.  It is the reverse process of compression. 

Compression is useful because it reduces resources required to store and transmit data. Data 

compression is subject to a space–time complexity trade-off. For instance, a compression scheme for 

video may require expensive hardware for the video to be decompressed fast enough to be viewed as 

it is being decompressed, and the option to decompress the video in full before watching it may be 

inconvenient or require additional storage.  
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UNIT 2 

 

Operating System 

An operating system is a program that acts as an interface between the user and the computer 

hardware and controls the execution of all kinds of programs. 

In technical terms, it is software which manages hardware. An operating System controls the 

allocation of resources and services such as memory, processors, devices and information. 

 
 

Functions of operating system 

Following are some of important functions of an operating System. 

 Memory Management 

 Processor Management 

 Device Management 

 File Management 

 Security 

 Control over system performance 

 Job accounting 

 Error detecting aids 

 Coordination between other software and users 

 

Memory Management 

Memory management refers to management of Primary Memory or Main Memory. Main memory is 

a large array of words or bytes where each word or byte has its own address.  

Main memory provides a fast storage that can be access directly by the CPU. So for a program to be 

executed, it must in the main memory. Operating System does the following activities for memory 

management. 

 Keeps tracks of primary memory i.e. what part of it are in use by whom, what part are not in 

use. 

 In multiprogramming, OS decides which process will get memory when and how much. 

 Allocates the memory when the process requests it to do so. 

 De-allocates the memory when the process no longer needs it or has been terminated. 
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Process Management 

In multiprogramming environment, OS decides which process gets the processor when and how 

much time. This function is called process scheduling. Operating System does the following 

activities for processor management. 

 Keeps tracks of processor and status of process. Program responsible for this task is known 

as traffic controller. 

 Allocates the processor (CPU) to a process. 

 De-allocates processor when processor is no longer required. 

 

Device Management 

OS manages device communication via their respective drivers. Operating System does the 

following activities for device management. 

 Keeps tracks of all devices. Program responsible for this task is known as the I/O controller. 

 Decides which process gets the device when and for how much time. 

 Allocates the device in the efficient way. 

 De-allocates devices. 

 

File Management 

A file system is normally organized into directories for easy navigation and usage. These directories 

may contain files and other directions. Operating System does the following activities for file 

management. 

 Keeps track of information, location, uses, status etc. The collective facilities are often 

known as file system. 

 Decides who gets the resources. 

 Allocates the resources. 

 De-allocates the resources. 

 

Resource Allocation 

The resources such as CPU, memory, I/O channels are needed by all user jobs, and their allocation is 

handled automatically by the operating system. Some problems to be handled by the operating 

system are: 

- mutual exclusion 

- process synchronization,  

- deadlock avoidance 

- security and protection 

 

Other Important Activities 
Following are some of the important activities that Operating System does. 

 Security -- By means of password and similar other techniques, preventing unauthorized 

access to programs and data. 

 Control over system performance -- Recording delays between request for a service and 

response from the system. 

 Job accounting -- Keeping track of time and resources used by various jobs and users. 

 Error detecting aids -- Production of dumps, traces, error messages and other debugging 

and error detecting aids. 

 Coordination between other software’s and users -- Coordination and assignment of 

compilers, interpreters, assemblers and other software to the various users of the computer 

systems. 
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CUI: character user interface or command-line user interface, CUI is a prompt used to interact 

with computer programs. It works by allowing the user (client) to issue commands as one or 

more lines of text (referred to as command lines) to a program. One of the CUI's uses is that it 

provides an easy way to implement programming scripts. 

The command-line user interface was the primary method of communicating with a computer 

from the first machines, all the way through the 1980s. Although it may still be accessed in most 

of today operating systems, it is utilized far less due to the ease of use and familiarity of the 

graphical user interface (GUI). The CUI, however, is still preferred by many advanced end users 

as its features provide them with more comprehensive control over an operating system's 

functions. 

Good examples of command lines include MS-DOS, Windows command line, Terminal, and the 

Linux command line. 

GUI 

GUI is what most modern computers make use of. This is an interface that makes use of 

graphics, images and other visual clues such as icons. This interface made it possible for a mouse 

to be used with a computer and interaction really became very easy as the user could interact 

with just a click of the mouse rather than having to type every time to give commands to the 

computer. 

Modern operating systems use a graphical user interface, or GUI (pronounced gooey). A GUI 

lets you use your mouse to click icons, buttons, and menus, and everything is clearly displayed 

on the screen using a combination of graphics and text. 

Icons 

•Small pictures that represent commands, files, or windows. 

 

Difference between CUI and GUI 

• CUI and GUI are user interface used in connection with computers 
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• CUI is the precursor of GUI and stands for character user interface where user has to type on 

keyboard to proceed. On the other hand GUI stands for Graphical User Interface which makes it 

possible to use a mouse instead of keyboard 

• GUI is much easier to navigate than CUI 

• There is only text in case of CUI whereas there are graphics and other visual clues in case of 

GUI 

• Most modern computers use GUI and not CUI 

• DOS is an example of CUI whereas Windows is an example of GUI. 

 

TYPES OF OPERATING SYSTEM 

The categories are: 

 Real-time operating system (RTOS) - Real-time operating systems are used to control 

machinery, scientific instruments and industrial systems. An RTOS typically has very little 

user-interface capability, and no end-user utilities, since the system will be a "sealed box" 

when delivered for use. A very important part of an RTOS is managing the resources of the 

computer so that a particular operation executes in precisely the same amount of time, every 

time it occurs. In a complex machine, having a part move more quickly just because system 

resources are available may be just as catastrophic as having it not move at all because the 

system is busy. 

 Single-user, single task - As the name implies, this operating system is designed to manage 

the computer so that one user can effectively do one thing at a time. The Palm OS for Palm 

handheld computers is a good example of a modern single-user, single-task operating system. 

 Single-user, multi-tasking - This is the type of operating system most people use on their 

desktop and laptop computers today. Microsoft's Windows and Apple's MacOS platforms are 

both examples of operating systems that will let a single user have several programs in 

operation at the same time. For example, it's entirely possible for a Windows user to be 

writing a note in a word processor while downloading a file from the Internet while printing 

the text of an e-mail message. 

 Multi-user - A multi-user operating system allows many different users to take advantage of 

the computer's resources simultaneously. The operating system must make sure that the 

requirements of the various users are balanced, and that each of the programs they are using 

has sufficient and separate resources so that a problem with one user doesn't affect the entire 

community of users. Unix, VMS and mainframe operating systems, such as MVS, are 

examples of multi-user operating systems. 

 Batch Processing- Batch processing is a technique in which an Operating System collects 

the programs and data together in a batch before processing starts. An operating system does 

the following activities related to batch processing:  The OS defines a job which has 

predefined sequence of commands, programs and data as a single unit.  The OS keeps a 

number a jobs in memory and executes them without any manual information.  Jobs are 

processed in the order of submission, i.e., first come first served fashion.  When a job 

completes its execution, its memory is released and the output for the job gets copied into an 
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output spool for later printing or processing. Advantages  Batch processing takes much of 

the work of the operator to the computer.  Increased performance as a new job gets started 

as soon as the previous job is finished, without any manual intervention. Disadvantages  

Difficult to debug programs.  A job could enter an infinite loop.  Due to lack of protection 

scheme, one batch job can affect other pending jobs. 

 

 
 

Time-sharing Operating Systems 

Time-sharing is a technique which enables many people, located at various terminals, to use a 

particular computer system at the same time. Time-sharing or multitasking is a logical extension 

of multiprogramming. Processor's time which is shared among multiple users simultaneously is 

termed as time-sharing. 

 

The main difference between Multiprogrammed Batch Systems and Time-Sharing Systems is 

that in case of Multiprogrammed batch systems, the objective is to maximize processor use, 

whereas in Time-Sharing Systems, the objective is to minimize response time. 

 

Multiple jobs are executed by the CPU by switching between them, but the switches occur so 

frequently. Thus, the user can receive an immediate response. For example, in a transaction 

processing, the processor executes each user program in a short burst or quantum of 

computation. That is, if n users are present, then each user can get a time quantum. When the 

user submits the command, the response time is in few seconds at most. 

 

The operating system uses CPU scheduling and multiprogramming to provide each user with a 

small portion of a time. Computer systems that were designed primarily as batch systems have 

been modified to time-sharing systems. 

Advantages of Timesharing operating systems are as follows: 

 Provides the advantage of quick response 

 Avoids duplication of software 

 Reduces CPU idle time 

Multiprogramming 

Sharing the processor, when two or more programs reside in memory at the same time, 

is referred as multiprogramming. Multiprogramming assumes a single shared processor. 

Multiprogramming increases CPU utilization by organizing jobs so that the CPU always has 

one to execute. 
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The following figure shows the memory layout for a multiprogramming system. 

 
An OS does the following activities related to multiprogramming. 

 The operating system keeps several jobs in memory at a time. 

 This set of jobs is a subset of the jobs kept in the job pool. 

 

Multiprogramming operating systems monitor the state of all active programs and 

system resources using memory management programs to ensures that the CPU 

is never idle, unless there are no jobs to process. 

Advantage 

 High and efficient CPU utilization. 

 User feels that many programs are allotted CPU almost simultaneously. 

Disadvantages 

 CPU scheduling is required. 

 To accommodate many jobs in memory, memory management is required. 

 

Multitasking 

Multitasking is when multiple jobs are executed by the CPU simultaneously by switching 

between them. Switches occur so frequently that the users may interact with each program 

while it is running. An OS does the following activities related to multitasking: 
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 The user gives instructions to the operating system or to a program directly, and receives an 

immediate response. 

 The OS handles multitasking in the way that it can handle multiple operations / executes 

multiple programs at a time. 

 Multitasking Operating Systems are also known as Time-sharing systems. 

 These Operating Systems were developed to provide interactive use of a computer system at 

a reasonable cost. 

 A time-shared operating system uses the concept of CPU scheduling and multiprogramming 

to provide each user with a small portion of a time-shared CPU. 

 Each user has at least one separate program in memory. 

 A program that is loaded into memory and is executing is commonly referred to as a process. 

 When a process executes, it typically executes for only a very short time before it either 

finishes or needs to perform I/O. 

 Since interactive I/O typically runs at slower speeds, it may take a long time to complete. 

During this time, a CPU can be utilized by another process. 

 The operating system allows the users to share the computer simultaneously. Since each 

action or command in a time-shared system tends to be short, only a little CPU time is 

needed for each user. 

 As the system switches CPU rapidly from one user/program to the next, each user is given 

the impression that he/she has his/her own CPU, whereas actually one CPU is being shared 

among many users. 

Real-Time Operating System 

A real-time system is defined as a data processing system in which the time interval required to 

process and respond to inputs is so small that it controls the environment. The time taken by the 

system to respond to an input and display of required updated information is termed as the response 

time. So in this method, the response time is very less as compared to online processing. 

 

Real-time systems are used when there are rigid time requirements on the operation of a processor or 

the flow of data and real-time systems can be used as a control device in a dedicated application. A 

real-time operating system must have well-defined, fixed time constraints, otherwise the system will 

fail. For example, Scientific experiments, medical imaging systems, industrial control systems, 

weapon systems, robots, air traffic control systems, etc. 

There are two types of real-time operating systems. 
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Hard real-time systems 

Hard real-time systems guarantee that critical tasks complete on time. In hard real-time 

systems, secondary storage is limited or missing and the data is stored in ROM. In these 

systems, virtual memory is almost never found. 

Soft real-time systems 

Soft real-time systems are less restrictive. A critical real-time task gets priority over other 

tasks and retains the priority until it completes. Soft real-time systems have limited utility 

than hard real-time systems. For example, multimedia, virtual reality, Advanced Scientific 

Projects like undersea exploration and planetary rovers, etc. 

Distributed processing is a phrase used to refer to a variety of computer systems that use more than 

one computer (or processor) to run an application. This includes parallel processing in which a 

single computer uses more than one CPU to execute programs 

Distributed computing is a technique of distributing the information over number of devices. 

Devices may be computers or data terminals. Devices are interconnected with communication 

facilities. 

Microsoft Windows 

Microsoft created the Windows operating system in the mid-1980s. Over the years, there have been 

many different versions of Windows, but the most recent ones are Windows 10 (released in 2015), 

Windows 8 (2012), Windows 7 (2009), and Windows Vista (2007). Windows comes pre-loaded on 

most new PCs, which helps to make it the most popular operating system in the world. 

Mac OS X 

Mac OS is a line of operating systems created by Apple. It comes preloaded on all new Macintosh 

computers, or Macs. All of the recent versions are known as OS X (pronounced O-S Ten), and the 

specific versions include El Capitan (released in 2015), Yosemite (2014), Mavericks (2013), 

Mountain Lion (2012), and Lion (2011). 

Linux 

Linux  is a family of open-source operating systems, which means they can be modified and 

distributed by anyone around the world. This is different from proprietary software like Windows, 

which can only be modified by the company that owns it. The advantages of Linux are that it is free, 

and there are many different distributions—or versions—you can choose from. 

Different distributions of Linux 

 Ubuntu,  

 Linux Mint 

 Fedora  

Operating systems for mobile devices 
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The operating systems we've been talking about so far were designed to run on desktop and laptop 

computers. Mobile devices such as phones, tablet computers, and MP3 players are different from 

desktop and laptop computers, so they run operating systems that are designed specifically for 

mobile devices. Examples of mobile operating systems include  

 Apple iOS 

 Google Android 

Disk Defragmenter is a utility in Microsoft Windows designed to increase access speed by 

rearranging files stored on a disk to occupy contiguous storage locations, a technique called 

defragmentation. 

Disk Cleaning is a computer maintenance utility included in Microsoft Windows designed to free up 

disk space on a computer's hard drive. The utility first searches and analyzes the hard drive for files 

that are no longer of any use, and then removes the unnecessary files. There are a number of 

different file categories that Disk Cleanup targets when performing the initial disk analysis: 

 Compression of old files 

 Temporary Internet files 

 Temporary Windows files 

 Downloaded program files 

 Recycle Bin 

 Removal of unused applications or optional Windows components 

 Offline web pages (cached) 

MS Windows 

Windows XP is a personal computer operating system produced by Microsoft as part of 

the Windows NT family of operating systems. The operating system was released to manufacturing 

on August 24, 2001, and generally released for retail sale on October 25, 2001. 

 

Windows XP is a graphical user interface (GUI). It has pictures (graphical) that you use (user) to 

communicate (interface) with the computer. This type of system is popular because it's logical, fun, 

and easy to use. 

This operating system has multi-tasking capabilities, meaning it can run several applications at the 

same time. Multi-tasking allows you to view this lesson on the Internet at the same time you practice 

using other applications with Windows XP. 

History of Windows: 

 

Versions Year 

Windows 10 Nov.1983 

Windows 1.0 Nov.1985 

Windows 2.0 09 Dec.1987 

Windows 3.0 22 May.1990 

Windows 95 August 1995 
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Windows 98 June 1998 

Windows 2000 Feb.2000 

Windows XP 25 Oct. 2001 

Windows  Vista 2007 

Windows 7 22 July 2009 

Windows 8 26 Oct. 2012 

 

The New and updated features in the new program are: 

 Windows XP is faster, smarter, safer 

 Windows XP is easier to learn and use 

 Windows XP offers better help for 

every task 

 Playing music, video and CDs 

 Offers wizard 

 User interface 

 Infrastructure 

 Networking and internet functionality 

 

Windows XP editions 

 Home and Professional 

 Starter Edition 

 Media Center Edition 

 Tablet PC Edition 

 Subscription and pre-paid editions 

 64-bit editions 

 Editions for embedded systems 

 

Windows XP is an operating system 

 Windows XP is a collection of programs, which enables the entire pc to work. Among Windows‘ 

most important tasks are: 

 Assist in starting the pc. 

 Control and handling of all hardware, including RAM, I/O, cards and controllers. 

 Read-in of a graphics user interface with windows, menu bars etc. 

 Forms a platform for the user programs (applications) like Word, Internet Explorer, and 

Photoshop etc. 

 Handling of user data in files. 

 

Beyond the pure operating system tasks Windows XP includes a large collection of smaller and 

larger tools. Among others Windows XP comes with Internet Explorer and the multimedia player 

Windows Media Player, which are independent user programs. 
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Windows XP is both an operating system and a program package. 

 

Desktop 

Desktops in a Windows is utility that allows users to manage applications on up to four virtual 

desktops, all accessible using the tray icon interface. 4. When referring to an operating system or 

GUI, the Desktop is a system of organization of icons on a screen. The Microsoft Windows Desktop 

was first introduced with Microsoft Windows 95 and has been included with every version of 

Windows since then. 

 
The desktop contains: 

 Start button: This is one of the most important tools you will use while working with 

Windows XP. The Start button allows you to open menus and start applications. 

 Taskbar: This is primarily used to switch between open windows and applications. Learn 

more about using the taskbar in a later lesson. 

 Icons (or graphical pictures): This represents applications, files, and other parts of the 

operating system. By default, Windows XP provides you with one desktop icon, the Recycle 

Bin.  

 Windows Notification Area 
 Time and Date: The date and time is also shown on the Desktop, in the notification area on 

the taskbar. If the date and time is incorrect, you can change the date and time right from the 

Desktop. 

 

Exploring Windows Explorer 
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Windows Explorer is a file management tool that lets you create, rename, and delete folders. It also 

allows you to copy, print, move, delete, rename, and manage files. 

To open Windows Explorer: 

1. Open My Documents. 

2. Click the Folders button on the Navigation toolbar. 

3. A list of folders opens in the left pane. 

To explore Windows Explorer: 

1. With Windows Explorer open, scroll until you see the Control Panel icon in the left pane. 

2. Click the Control Panel icon. The contents (of the Control Panel folder) display in the right 

pane. 

3. Practice viewing other folders in the list. 

4. To close Windows Explorer, click the small black X in the upper right of the list OR click 

the Folder button. 

 

The Taskbar 

The taskbar is the small blue bar you see at the bottom of your desktop. It contains the Start 

menu and the Quick Launch bar, which contains icons for Internet Explorer, Windows Media 

Player, and Show Desktop. Click an icon to open a program. Click Show Desktop to quickly view 

your desktop without closing any programs or windows. 

 
 

The box on the right is called the Notification Area. Microsoft also uses the Notification Area to 

remind you when software updates are available for download. 

 
 

When you open or minimize a window or program, a rectangular button appears on the taskbar 

that shows the name of the application.  

 

The Start menu 

When you click the Start button, the Start menu appears. The Start menu is your path to the 

applications on your computer. It contains two columns. The left side of the Start menu lists 

programs, while the right side allows access to common Windows folders (My Documents, for 

example). It also provides access to Help and Support, Search, and Run. If you select All 

Programs, a pop-up menu appears. Pop-up menus like this are called cascading menus. If a 

cascading menu is available, a small black triangle appears next to the name of the application or 

function. 

To explore the Start menu: 

1. Click the Start button. 

2. Move the mouse pointer to each option, and view the various cascading menus. 

3. Click (or roll your mouse pointer over) All Programs. 

4. Move the mouse pointer to the right, and view other cascading menus. 

5. To exit the menus, click outside the menu area or press Esc on your keyboard. 
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The Recycle Bin 

The Recycle Bin is nothing more than a space on the hard disk reserved to store information that is 

deleted so that in the event of deleting a file or folder by mistake it is possible to retrieve it. By 

default the Recycle Bin restores files or folders to the place from where they were deleted. If, for 

example, a file is deleted from D:\my documents, when it is restored it will go to that folder. 

The Recycle Bin will maintain the deleted documents until it is emptied. 

To open the Recycle Bin place the cursor on Desktop and double-click on the Recycle 

Bin icon.  

 

Restoring Files or Folders 

To restore all of the elements from the Recycle Bin click on the green arrow on the left side that 

says restore all items. 

 

If we only want to restore some of the elements: 

1) Select the elements to be restored by clicking on them. If the elements are not in subsequent order, 

use the Ctrl key to select them or the Shift key if they are one below the other. 

2) Once selected, a dialog box will appear on the green arrow on the left that will say Restore this 

item or Restore the selected items. 

The selected files will return to where they were located before deletion. 

 

Deleting Files or Folders from the Recycle Bin 

Before deleting any element from the Recycle Bin you need to realize that once it is deleted it cannot 

be retrieved or restored. 

 If you want to delete any file or folder from the Recycle Bin follow these steps: 
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1) Select the Elements to be deleted. 

2) Click on ; this will delete the selected elements. You can also do this by pressing 

the Delete button. 

The selected files will disappear and cannot be restored. 

 

My Computer 

It is another tool you can use to manage files and folders. With this tool, you can create, rename 

and move folders and copy, print, move, delete and rename files. It also allows you to gain access 

to other 

system tools. 

To open My Computer: 

1. Double-click the My Computer icon on the desktop. 

2. My Computer opens. 

 

My Network Places overview 

My Network Places displays shortcuts to shared computers, printers, and other resources on the 

network. The shortcuts are created automatically in My Network Places whenever you open a shared 

network resource, such as a printer or shared folder. 

 

Open My Network Places 

 To open My Network Places, click Start, and then click My Computer. Under Other Places, 

click My Network Places.  

 The View workgroup computers task is displayed in My Network Places when your 

computer is in a workgroup and not in a domain. Double-click this icon to narrow your 

search to only those computers, printers, and resources that share a workgroup with your 

computer.  

 If your computer is connected to a workgroup that has less than 32 computers, Windows will 

automatically create shortcuts in My Network Places to the shared resources in your 

workgroup.  

 To add a shortcut in My Network Places to a folder on a Web server, the Web server must 

support network places.. 

 

My Documents 

The My Documents folder is your own personal folder in which you can store your documents, 

graphics, and other personal files. You can change the target if you want My Documents to point to a 

different folder location.  

 Change the Default Location of the My Documents Folder 

 To change the default location of the My Documents folder, follow these steps:  

 Click Start, and then point to My Documents.  

 Right-click My Documents and then click Properties. Click the Target tab.  

 

User Accounts 

To get at the settings for the User Accounts, click Start and then Control Panel. From the Control 

Panel, double click User Accounts.  

 We can create a new user account. 

 We can make the account as password protected. 

 Through admin we can even change the password. 
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Windows XP Accessories Applications:  

 Calculator,  

 Notepad,  

 WordPad,  

 Paint  
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1. Using Windows XP Calculator 

Like a calculator you keep in a desk drawer, the 

Windows Calculator is small but saves you time by 

performing all the calculations common to a standard 

calculator. 

The Standard Windows Calculator works so much like a 

pocket calculator that you need little help getting started. 

To display the Calculator, open the Start menu and 

choose Programs, Accessories, Calculator. The 

Calculator opens in the same view (Standard or 

Scientific) in which it was displayed the last time it was 

used. 

 To close the Calculator, click the Close button in the 

title bar. If you use the Calculator frequently, however, 

don't close it; click the Minimize button to minimize the 

Calculator to a button on the taskbar. 

The Calculator has only three menus: Edit, View, and Help. The Edit menu contains two simple 

commands for copying and pasting; the View menu switches between the Standard and Scientific 

views; and the Help menu is the same as in all Windows accessories. 

 

 

2.   Using Windows XP Notepad  
Notepad is a miniature text after the 

calculations are performed. To enter 

numbers from the editor.  Just as you use 

a notepad on your desk, you can use 

Notepad to take notes onscreen while 

working in other Windows applications. 

 

Because Notepad stores files in text 

format, almost all word processing 

applications can retrieve Notepad's files. 

However, if you want the capability of 

formatting your documents, you'll need a true word processor. 

 

Starting Notepad 

To start Notepad, open the Start menu and choose Programs, Accessories, Notepad. Notepad starts 

up and displays a blank document in the Notepad window . 

 

Working with Documents in Notepad 

You can move the insertion point by using either the mouse or the keyboard. You select and edit text 

in Notepad the same way you select and edit text in WordPad. 

Limited formatting is available from the File, Page Setup command. You can change margins and 

add a header or footer, but you cannot format characters or paragraphs in any way. You also can use 

the Tab, Spacebar, and Backspace keys to align text. Tab stops are preset at every eight characters. 
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With the commands on Notepad's Edit menu, you can cut, copy, and move text from one place in a 

file to another. Text that you cut or copy is stored in the Clipboard. When you paste text, the contents 

of the Clipboard are copied from the Clipboard to the document at the location of the insertion point. 

 

  

 3. Using Windows XP WordPad 

 

Word Pad is the word processor that comes 

with Windows XP that can perform most 

basic word processing tasks. Although it is 

not nearly as powerful and versatile as a 

full-featured word processing application 

(such as Microsoft Word XP), it is much 

more powerful than Notepad, the text 

editor that comes with Windows XP. 

 

Creating a New Document in WordPad 

WordPad is located in the Accessories 

submenu of the Start menu. To start 

WordPad, open the Start menu and choose Programs, Accessories, WordPad. The WordPad window 

appears. When you first open WordPad, you are presented with a blank document. 

  

 

4.Using Windows XP Paint 

Paint is n easy-to-learn graphics application 

that you can use to create and modify graphics 

images. 

 

Steps for starting Windows Paint 

To start Paint, click Start, Programs, 

Accessories, Paint. Paint starts up and opens a 

new, empty Paint file 

 

5.Using Windows XP Entertainment 

 Windows XP includes entertainment 

programs for playing CDs, viewing 

multimedia files, and recording and playing 

back sounds.  

It is capable of performing many tasks like: 

1. Playing Games 

2. Changing the Volume 

3. Playing a Sound with Sound Recorder 

4. Playing an Audio CD 

5. Working with Media Player Controls 

6. Changing the Visualizations 

7. Copying CD Tracks 

8. Using the Media Library 
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9. Creating a Playlist 

10. Tuning into the Radio 

11. Changing the Skin for Windows Media Player 

12. Playing a Video Clip 

13. Importing a Movie with Windows Movie Maker 

 

6. Using Windows XP Address Book 

 
 

The Address Book provides a convenient place to store contact information for easy retrieval from 

programs such as Outlook, Outlook Express, Internet Explorer, NetMeeting, and Microsoft Phone 

System. You can search for people and businesses, create groups of contacts for mailing lists, and 

send and receive electronic business cards. 

 Start Click All Programs, Accessories, Address Book 

Address Book Window will appear. 

 

Functions of address book as follows: 

 Create a new entry 

 Delete the existing entry 

 Edit the existing entry and etc 

 

Changing Mouse Pointer 

1. Open Mouse Properties by clicking the Start button The Start button, and then clicking 

Control Panel. In the search box, type mouse, and then click Mouse. 

2. Click the Pointers tab, and then do one of the following:        

 To give all of your pointers a new look, click the Scheme drop-down list, and then click a 

new mouse pointer scheme. 

 To change an individual pointer, under Customize, click the pointer you want to change 

in the list, click Browse, click the pointer you want to use, and then click Open. 

3. Click OK. 
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To change your desktop background 

1. Open Display in Control Panel. 

To open Display, click Start, click Control Panel, click Appearance and Themes, and then 

click Display.  

2. On the Desktop tab, do one or more of the following: 

• 
Click a picture in the Background list. In Position, click Center, Tile, or Stretch. 

• Click Browse to search for a background picture in other folders or on other drives. You can 

use files with the following extensions: .bmp, .gif, .jpg, .dib, .png, .htm. In Position, 

click Center, Tile, or Stretch. 

• 
Select a color from Desktop color. The color fills the space not used by a picture. 

 

Note 

• To open Display, click Start, click Control Panel, click Appearance and Themes, and then 

click Display.  

• You can use a personal picture as a background. All of your personal pictures located in My 

Pictures are listed by name in the Background list. 

• You can save a picture from a Web site as a background. Right-click the picture and then click Set 

as Background. The picture is listed in the Background box as Internet Explorer Background. 

• If you choose an .htm document as your background picture, the Position options are unavailable. 

The .htm document is automatically stretched to fill your background. 

 

Copying and Moving Files and Folders 

Sometimes you will need to move a file from one folder to another, or copy a file from one folder to 

another, leaving the file in the first location and placing a copy of it in the second. You can move or 

copy a file or folder using a variety of methods. If the file or folder and the location where you want 

to move it are visible in a window or on the desktop, you can simply drag the item from one location 

to the other. Moving a file or folder on the same disk relocates it whereas dragging it from one disk 

to another copies it so that it appears in both locations. When the destination folder or drive is not 

visible, you can use the Cut (to move), Copy, and Paste commands on the Edit menu to move or 

copy the items. 

Copy a File or Folder 

1.  Open the drive or folder containing the file or folder you want to copy. 

2.  Select the files or folders you want to copy. 
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Move a File or Folder 

1.  Open the drive or folder containing the file or folder you want to move. 

2.  Select the files or folders you want to move. 
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3. Click the Organize button on the toolbar, and then click Cut. 

4.  Display the destination folder where you want to move the files or folder. 

5.  Click the Organize button on the toolbar, and then click Paste. 

 

Copy or Move a File or Folder Using Drag and Drop 

1.  Open the drive or folder containing the file or folder you want to copy or move. 

2.  Select the files or folders you want to copy or move. 

 

3. In the Navigation pane, point to a folder list to display the expand and collapse arrows. 

4.  Click the arrows to display the destination folder, and then click the destination folder. 

5.  Right-click the selected files or folders, drag to the destination folder, and then click Copy 

Here or Move Here. 

 

 

OLE (Object Linking and Embedding) 

Stands for "Object Linking and Embedding." OLE is a framework developed by Microsoft (way 

back in Windows 3.1) that allows you to take objects from a document in one application and place 

them in another. For example, OLE may allow you to move an image from a photo-editing program 

into a word processing document. 
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The OLE technology was initially created to allow the linking of objects between "compound 

documents," or documents that support multiple types of data. Microsoft has since developed OLE 

into a wider standard, known as the Component Object Model (COM). COM is supported by Mac, 

Unix, and Windows systems, but is primarily used with Microsoft Windows. The COM framework 

is the foundation of ActiveX, which allows developers to create interactive content for the Web 

OLE (Object Linking and Embedding) is Microsoft's framework for a compound document 

technology. Briefly, a compound document is something like a display desktop that can contain 

visual and information objects of all kinds: text, calendars, animations, sound, motion video, 3-D, 

continually updated news, controls, and so forth. Each desktop object is an independent program 

entity that can interact with a user and also communicate with other objects on the desktop. Part of 

Microsoft's ActiveX technologies, OLE takes advantage and is part of a larger, more general 

concept, the Component Object Model (COM) and its distributed version, DCOM. An OLE object is 

necessarily also a component (or COM object). OLE contains about 660 new function calls or 

individual program interfaces in addition to those already in Win32. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
B.Com 1st Sem.        Subject- Introduction to Computer Fundamental and PC Software 
 

 

45, Anurag Nagar, Behind Press Complex, Indore (M.P.) Ph.: 4262100, www.rccmindore.com 
46 

 

UNIT 3 

Microsoft Word 

Word processor 

A word processor is an electronic device or computer application software that performs word 

processing: the composition, editing, formatting and sometimes printing of any sort of written 

material. Word processing can also refer to advanced shorthand techniques, sometimes used in 

specialized contexts with a specially modified typewriter. 

The word processor emerged as a stand-alone office machine in the 1970s and 1980s, combining the 

keyboard text-entry and printing functions of an electric typewriter with a dedicated computer 

processor for the editing of text. 

 

Characteristics 

Word processing typically implies the presence of text manipulation functions that extend beyond a 

basic ability to enter and change text, such as automatic generation of: 

 batch mailings using form letter template and an address database (also called mail merging); 

 indices of keywords and their page numbers; 

 tables of contents with section titles and their page numbers; 

 tables of figures with caption titles and their page numbers; 

 cross-referencing with section or page numbers; 

 footnote numbering; 

 New versions of a document using variables (e.g. model numbers, product names, etc.) 

 

Examples of different word processing software are: 

 WordPerfect 

 Microsoft Word 

 WordMark 

 Lotus WordPro 

 Procedure Write 
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Types of word processor:- 

 

 Dedicated word processor 

 Standard word processor software packages 

 Word processing packages on minicomputer 

 

Microsoft office Word:- 

Microsoft Office Button :- After clicking you get the Menu to create, open, save and perform 

other operations 
The Ribbon:- The Ribbon is the panel at the top portion of the document. It has seven tabs: Home, 

Insert, Page Layout, References, Mailings, Review, and View that contain many new and existing 

features of Word.  

Each of the tabs contains the following tools: 

 Home: Clipboard, Fonts, Paragraph, Styles, and Editing.  

  Insert: Pages, Tables, Illustrations, Links, Header & Footer, Text, and Symbols 

  Page Layout: Themes, Page Setup, Page Background, Paragraph, Arrange 

  References: Table of Contents, Footnote, Citation & Bibliography, Captions, Index, and 

Table of Authorities 

  Mailings: Create, Start Mail Merge, Write & Insert Fields, Preview Results, Finish 

 Review: Proofing, Comments, Tracking, Changes, Compare, Protect 

  View: Document Views, Show/Hide, Zoom, Window, Macros 

 

Ruler: - Can use to change the format of your document quickly. 

Text area: - The area for writing the document is called Text Area. 

Status Bar: - appears at the very bottom of your window and provides the information about the 

current page and number of words in your document. 

Scroll Bar: - you have two types of scroll bar i.e. horizontal and vertical scroll bar to move the 

document. 
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Formatting Features of Ms Word:- 

 

 
 

 

The commonly used are as follows:- 

 Bold and italic 

 Underlined 

 Font style 

 Font size 

 Text color 

 Indent 

 Alignment 

 

To format font size: 

 Select the text you wish to modify. 
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 Left-click the drop-down arrow next to the font size box on the Home tab. The font size 

drop-down menu appears. 

 Move your cursor over the various font sizes. A live preview of the font size will appear in 

the document. 

 Left-click the font size you wish to use. The font size will change in the document. 

 

To format font style: 

 Select the text you wish to modify. 

 Left-click the drop-down arrow next to the font style box on the Home tab. The font style 

drop-down menu appears. 

 Move your cursor over the various font styles. A live preview of the font will appear in the 

document. 

 Left-click the font style you wish to use. The font style will change in the document. 

 

To format font color: 

 Select the text you wish to modify. 

 Left-click the drop-down arrow next to the font color box on the Home tab. The font color 

menu appears. 

 Move your cursor over the various font colors. A live preview of the color will appear in the 

document. 

 Left-click the font color you wish to use. The font color will change in the document. 

 

 

To use the bold, italic, and underline commands: 

 Select the text you wish to modify. 

 Click the bold, italic, or underline command in the Font group on the Home tab. 

 

To change the text case: 

 Select the text you wish to modify. 

 Click the Change Case command in the Font group on the Home tab. 

 Select one of the case options from the list. 

 

To change text alignment: 

 Select the text you wish to modify. 

 Select one of the four alignment options from the Paragraph group on the Home tab. 

o Align Text Left: Aligns all of the selected text to the left margin. 

o Center: Aligns text an equal distance from the left and right margins. 

o Align Text Right: Aligns all of the selected text to the right margin. 

o Justify: Justified text is equal on both sides and lines up equally to the right and left 

margins. Traditionally, many books, newsletters, and newspapers use full 

justification. 

 

Working with text:- 

To insert text: 

 Move your mouse to the location you wish text to appear in the document. 

 Left-click the mouse. The insertion point appears. 

 Type the text you wish to appear. 
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To delete text: 

 Place your cursor next to the text you wish to delete. 

 Press the Backspace key on your keyboard to delete text to the left of the cursor. 

 Press the Delete key on your keyboard to delete text to the right of the cursor. 

 

To select text: 

 Place the insertion point next to the text you wish to select. 

 Left-click your mouse and while holding it down, drag your mouse over the text to select it. 

 Release the mouse button. You have selected the text. A highlighted box will appear over the 

selected text. 

When you select text or images in Word, a hover toolbar with formatting options appears. This 

makes formatting commands easily accessible, which can save you time. 

 

To copy and paste text: 

 Select the text you wish to copy. 

 Click the Copy command on the Home tab. 

 Place your insertion point where you wish the text to appear. 

 Click the Paste command on the Home tab. The text will appear. 

 
To drag and drop text: 

 Select the text you wish to copy. 

 Left-click your mouse, and drag the text to the location you wish it to appear. The cursor will 

have a text box underneath it to indicate that you are moving text. 

 
 

 

Word Art 

Word Art are styles that can be applied to text to create a visual effect. To apply Word Art:- 

 Select text 

 Click insert tab 

 Click word Art 

 Choose the Word Art 

 Select the Word Art 
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 Click the format tab from the drawing 

tools 

 Click Word Art button  

 

Working with Header, Footers and Footnotes 

The header is a section of the document that appears in the top margin, while the footer is a section 

of the document that appears in the bottom margin. Headers and footers generally contain 

information such as page number, date, and document name.  

Header: - Header consists of text and graphics appears at the top of every page of a document. 

Footers: - Footers appears at the bottom of every page in the same document. 

For e.g.: - you can date page number, the time and date, a company logo, the document title. 

 

Steps to insert header and footers:- 

 There are different options to inset header and footer they are as follows:- 

 Insert the same header or footer on each page 

 Insert predefined header and footer 

 Insert custom header and footer 

 Make the first page header or footer different from the rest of the pages. 

 Make the header or footer different for odd and even pages. 

 Make the header or footer different in each section or chapter 

 Use documents section breaks to vary the header or footer. 

 Use the same header or footer across section boundaries 

 Change the contents of a header or footer 

 Insert a page number 

 

To insert a header or footer: 

 Select the Insert tab. 

 Click either the Header or Footer command. A menu appears with a list of built-in 

options you can use. 

 Left-click one of the built-in options, and it will appear in the document. 

 

OR 

 Left-click Blank to select it. 
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 The Design tab with Header and Footer tools is active. 

 
 

 Type information into the header or footer. 

 
 

To insert the date or time into a header or footer: 

 With the header or footer section active, click the Date & Time command. 
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 Select a date format in the dialog box that appears. 

 Click OK. The date and time now appear in the document. 

 

Other header and footer options 

There are many other header and footer options you can use to design these sections of your 

document. From the Header and Footer Tools Design tab, you can see all of your design options.  

 

Footnotes and end notes:- 

 A footnote or an endnote consists of two linked parts — the note reference mark (note 

reference mark: A number, character, or combination of characters that indicates that 

additional information is contained in a footnote or endnote.) and the corresponding note text. 

 When you add, delete, or move notes that are automatically numbered, Word renumbers the 

footnote and endnote reference marks. 

 

To insert a foot note:- 

 In Print Layout view, click where you want to insert the note reference mark.  

 On the References tab, in the Footnotes group, click Insert Footnote or Insert Endnote.  

 To make changes to the format of footnotes or endnotes, click the Footnotes Dialog Box 

Launcher, and do one of the following:  

 In the Number format box, click the format that you want.  

 To use a custom mark instead of a traditional number format, click Symbol next to Custom 

mark, and then choose a mark from the available symbols.  

 Click Insert.  

 Type the note text.  

 Double-click the footnote or endnote number to return to the reference mark in the document.  

 

Tables:- 

A table is a grid of cells arranged in rows and columns. Tables can be customized and are useful for 

various tasks such as presenting text information and numerical data.  

 

To convert existing text to a table: 

 Select the text you wish to convert. 

 Select the Insert tab. 
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 Click the Table command. 

 Select Convert Text to Table from the menu. A dialog box appears. 

 
 Choose one of the options in the Separate text at: section. This is how Word knows what 

text to put in each column. 

 

 Click OK. The text appears in a table. 

To add a row above an existing row: 

 Place the insertion point in a row below the location where you wish to add a row. 

 Right-click the mouse. A menu appears. 

 Select Insert  Insert Rows Above. 

 

A new row appears above the insertion point. 

You can also add rows below the insertion point. Follow the same steps, but select Insert Rows 

Below from the menu. 

To add a column: 

 Place the insertion point in a column adjacent to the location where you wish the new 

column to appear. 

 Right-click the mouse. A menu appears. 

 Select Insert  Insert Columns to the Left or Insert Columns to the Right. A new 

column appears. 

 

To delete a row or column: 

 Select the row or column. 

 Right-click your mouse, and a menu appears. 

 Select Delete Columns or Delete Rows. 

 

To apply a table style: 

 Select the table. A Table Tools Design tab now appears on the Ribbon. 

 Select the Design tab to access all of the Table Styles and Options. 

 Click through the various styles in the Table Styles section. 

 Left-click a style to select it. The table style will appear in the document. 

 

You can modify which table styles are displayed. In the Table Styles Options, you can select and 

deselect various table options 
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To insert a blank table: 

 Place your insertion point in the document where you want the table to appear. 

 Select the Insert tab. 

 Click the Table command. 

 Drag your mouse over the diagram squares to select the number of columns and rows in the 

table. 

 Left-click your mouse, and the table appears in the document. 

 Enter text into the table. 

Modify a table using the layout tab 

When you select a table in Word 2007, Design and Layout tabs appear under Table Tools on the 

Ribbon. Using commands on the Layout tab, you can make a variety of modifications to the table, 

including: 

 Adding and deleting columns 

 Adding and deleting rows 

 Changing the cell size 

 Aligning cell text 

 Changing text direction 

 Merging and splitting cells 

 

 
 

Other Table handling Features: 

 Insert tables by insert table. 

 Drawing a table 

 Adding text into the table 

 Formatting text within a table 

 Selecting a part of table 

 Align table 

 Inserting rows, columns, and cells 

 

To insert a picture: 

 Place your insertion point where you want the image to appear. 

 Select the Insert tab. 

 Click the Picture command in the Illustrations group. The Insert Picture dialog box appears. 
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 Select the image file on your computer. 

 Click Insert, and it will appear in your document. 

Left-click a corner sizing handle, and while holding down the mouse button resize the image. The 

image retains its proportions. 

 

To wrap text around an image: 

 Select the image. 

 Select the Picture Tools Format tab. 

 Click the Text Wrapping command in the Arrange group. 

 

 Left-click a menu option to select it. In this example, we selected Tight. 

 Move the image around to see how the text wraps for each setting. 

 The Position button has predefined text wrapping settings. The Position button is to the left of 

the Text Wrapping button. 

 Click the Position button, and a drop-down list of text wrapping options will appear. Hover 

over an option to see what it does. 

If you can‘t get your text to wrap the way you wish, click the Text Wrapping command, and 

select More Layout Options from the menu. You can make more precise changes in the Advanced 

Layout dialog box that appears. 

 

To crop an image: 

 Select the image. 

 Select the Format tab. 

 Click the Crop command. The black cropping handles appear. 

 Left-click and move a handle to crop an image. 

 Click the Crop command to deselect the crop tool. 

 Corner handles will crop the image proportionally. 

 

To compress a picture: 

 Select the picture. 

 Select the Format tab. 

 Click the Compress Pictures command in the Adjust group. A dialog box appears. 

 Click the Options button to access the Compression Setting dialog box. 

 Choose the target output. 

 Change any of the default picture settings you wish. 

 Click OK in the Compression Settings dialog box. 

 Click OK in the Compress Pictures dialog box. 

You need to monitor the file size of your images and documents that include images, 

especially if you send them via email. Cropping and resizing an image doesn‘t decrease 

the image file size, but compression does. 

 

Other picture tools 

There are many other things you can do to modify a picture. From the Format tab, some of the 

other useful commands include: 

 Change Picture command: Selects a new picture from your computer. 
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 Reset Picture command: Reverts to original image. 

 Brightness command: Adjusts the brightness of the image. 

 Color command: Adjusts the contrast of the image from light to dark. 

 Recolor command: Modifies the color in a variety of ways, including black and 

white, sepia, pink, and purple. 

 

To change the shape of a picture: 

 Select the picture. 

 Select the Format tab. 

 Click the Picture Shape icon. A menu appears. 

 Left-click a shape to select it. 

 

To apply a picture style: 

 Select the picture. 

 Select the Format tab. 

 Click the More drop-down arrow to display all of the picture styles. 

 Hover over a picture style to display a Live Preview of the style in the document. 

 Left-click a style to select it. 

 

To add a border to a picture manually: 

 Select the picture. 

 Select the Format tab. 

 Left-click the Picture Border commands, and selects a color. 

OR 

 Select Weight from the menu and choose a line weight. 

 

Adding clip art: 

 Select the Insert tab. 

 Click the Clip Art command in the Illustrations group. 

 
 The Clip Art options appear in the task pane on the right. 

 Enter keywords in the Search for: fields that are related to the image you wish to insert. 

 Click the drop-down arrow next to the Search in: field. 

 Select Everywhere to ensure that Word searches your computer and its online resources for 

an image that meets your criteria. 
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 Click the drop-down arrow in the Results should be: field. 

 Deselect any types of images you do not wish to see. 

 
 Click Go. 

To insert Clip Art: 

 Review the results from a Clip Art search. 

 Place your insertion point in the document where you wish to insert the Clip Art. 

 Left-click an image in the task pane. It will appear in the document. 

OR 

 Left-click the arrow next to an image in the task pane. 

 Select Insert, Copy, or any of the other options on the list. 
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Adding Shapes: 

 Click insert tab 

 Click the shape button 

 Choose the shape 

 Click on the document 

 Drag the cursor to expand the shape. 

 

Adding SmartArt: 

 Click insert tab 

 Click SmartArt button 

 Choose the Smartart 

 Click the SmartArt. 

 Drag it to the desired location in 

document 
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Using a Template 

A template is a predesigned document you can use to create new documents with the same 

formatting. With a template, many of the big document design decisions such as margin size, font 

style and size, and spacing are predetermined. 

To insert a template: 

 Click the Microsoft Office Button. 

 Select New. The New Document dialog box appears. 

 Select Installed Templates to choose a template on your computer. 

 
 Review the available templates. 

 Left-click a template to select it. 

 Click Create, and the template opens in a new window. 

 

Macros 

Macros are advanced features that can speed up editing or formatting you may perform often in a 

Word document. They record sequences of menu selections that you choose so that a series of 

actions can be completed in one step. 

Recording a Macro 

To record a Macro: 

 Click the View Tab on the Ribbon 

 Click Macros 

 Click Record Macro 

 

 Enter a name (without spaces) 

 Click whether you want it assigned to a button (on the Quick Access Toolbar) or 

the keyboard (a sequence of keys) 

 To assign the macro a button on the Quick Access Toolbar: 

 Click Button 
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 Under the Customize Quick Access Toolbar, select the document for which you 

want the Macro available 

 Under Choose Commands:  Click the Macro that you are recording 

 Click Add 

 Click OK to begin Recording the Macro 

 Perform the actions you want recorded in the Macro 

 Click on Macros 

 Click on Stop Recording Macros 

 To assign a macro button to a keyboard shortcut: 

 Click Keyboard 

 In the Press New Shortcut Key box, type the key sequence that you want and 

click Assign 

 Click Close to begin recording the Macro 

 Perform the actions you want recorded in the Macro 

 Click on Macros 

 Click on Stop Recording Macros 

 

Running a Macro 

running a macro depends on whether it‘s been added to the Quick Access Toolbar or if it‘s been 

given a Keyboard Shortcut. 

 To run a Macro from the Quick Access Toolbar, simply click the Macro Icon 

 To run a Macro from the Keyboard shortcut, simply press the keys that you have 

programmed to run the Macro. 

 

Mail Merge 

Mail Merge is used to create and print letters and other documents, such as a form letter that is 

sent to many customers. Each letter has the same kind of information, yet the content is unique. 

For example, in letters to your customers, each letter can be personalized to address each 

customer by name. The unique information in each letter comes from entries in a data source.  

The mail merge process entails the following overall steps: 

 Set up the main document: - The main document contains the text and graphics that are 

the same for each version of the merged document — for example, the return address or 

salutation in a form letter.  

 Connect the document to a data source:-A data source is a file that contains the 

information to be merged into a document. For example, the names and addresses of the 

recipients of a letter.  

 Refine the list of recipients or items. Microsoft Office Word generates a copy of the main 

document for each item, or record, in your data file. If your data file is a mailing list, 

these items are probably recipients of your mailing. If you want to generate copies for 

only certain items in your data file, you can choose which items (records) to include.  

 Add placeholders, called mail merge fields, to the document. When you perform the mail 

merge, the mail merge fields are filled with information from your data file.  

 Preview and complete the merge. You can preview each copy of the document before you 

print the whole set.  

 You use commands on the Mailings tab to perform a mail merge. 
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 You can also perform a mail merge by using the Mail Merge task pane, which leads you step by 

step through the process. To use the task pane, in the Start Mail Merge group on the Mailings tab, 

click Start Mail Merge, and then click Step by Step Mail Merge Wizard. 

Steps 1-3 

 Choose the type of document you wish to create. In this example, select Letters. 

 Click Next: Starting document to move to Step 2. 

 Select Use the current document. 

 Click Next: Select recipients to move to Step 3. 

 Select the Type a new list button. 

 Click Create to create a data source. The New Address List dialog box appears. 

o Click Customize in the dialog box. The Customize Address List dialog box appears. 

o Select any field you do not need and click Delete. 

o Click yes to confirm that you wish to delete the field. 

o Continue to delete any unnecessary fields. 

o Click Add. The Add Field dialog box appears. 

o Enter the new field name. 

o Click OK. 

o Continue to add any fields necessary. 

o Click OK to close the Customize Address List dialog box. 

To Customize the New Address List: 
 Enter the necessary data in the New Address List dialog box. 

 Click New Entry to enter another record. 

 Click Close when you have entered all your data records. 

 Enter the file name you wish to save the data list as. 

 Choose the location you wish to save the file. 

 Click Save. The Mail Merge Recipients dialog box appears and displays all the data records 

in the list. 

 Confirm the data list is correct and click OK. 

 Click Next: Write your letter to move to Step 4. 

 

Steps 4-6 

 Write a letter in the current Word document, or use an open, existing document. 

To Insert Recipient Data from the List: 

o Place the insertion point in the document where you wish the information to appear. 

o Select Address block, Greeting line, or Electronic postage from the task pane. A dialog 

box with options will appear based on your selection. 

OR 

o Select More Items. The Insert Merge Field dialog box will appear. 

o Select the field you would like to insert in the document. 

o Click Insert. Notice that a placeholder appears where information from the data record 

will eventually appear. 

o Repeat these steps each time you need to enter information from your data record. 

 Click Next: Preview your letters in the task pane once you have completed your letter. 
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 Preview the letters to make sure the information from the data record appears correctly in 

the letter. 

 Click Next: Complete the merge. 

 Click Print to print the letters. 

 Click All. 

 Click OK in the Merge to Printer dialog box. 

 Click OK to send the letters to the printer. 

 

The Mail Merge wizard allows you to complete the mail merge process in a variety of ways.  

 

MS Excel 2007 

 

Excel Basics:- 

Excel 2007 is the spreadsheet software in the Microsoft 2007 Office Suite. It allows you to store, 

organize, and analyze numerical and text data. 

 

Ribbons 

Located where taskbars used to be, ribbons graphically display the changing features as you click 

on the menu-bar tabs. It may be take you time to adjust to the new locations of familiar options, but 

ribbons may expose you to new commands and tools.  

 

 

The Ribbon provides you the below tabs:- 

 Home:- Change the Font, Paragraph and Heading styles and view the clipboard and editing 

options 

 Insert:- Insert pages, tables, illustrations, links, headers, footers, text and symbols 

 Page Layout:- Alter page setup, background, themes, paragraph properties, and arrangement 

of document 

 Formulas:- Insert functions and create custom formulas. 

 Data:- Get external data, sort, filter, and outline existing. 

 Review:- Use proofing techniques, insert comments, track changes, compare and protect 

documents 

 View:- Change document and window layout, show/hide thumbnails, and view/record 

macros 

 Add-Ins:- Customize toolbars 

 

Above the Ribbon in the upper-left corner is the Microsoft Office Button. From here, you can 

access important options such as New, Save, Save As, and Print. By default, the Quick Access 

Toolbar is pinned next to the Microsoft Office Button and includes commands such as Undo and 

Redo. 

 

At the bottom-left area of the spreadsheet, you will find worksheet tabs. By default, three worksheet 

tabs appear each time you create a new workbook. On the bottom-right area of the spreadsheet you 

will find page view commands, the zoom tool, and the horizontal scrolling bar. 
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To change page views: 

 Locate the Page View options in the bottom-right corner. The Page View options are 

Normal, Page Layout, and Page Break. 

 Left-click an option to select it. 

 

“The default is Normal View.” 

To add commands to the Quick Access Toolbar: 

 Click the arrow to the right of the Quick Access Toolbar. 

 Select the command you wish to add from the drop-down list. It will appear in the Quick 

Access Toolbar. 

 

Spreadsheets and Workbooks 

A spreadsheet is a grid of data divided into numbered rows and lettered columns. Each block in this 

grid is called a cell, and it can hold an individual piece of text or data. In Excel, a file/document is 

considered a spreadsheet, although it is commonly referred to as a workbook. 

 

Worksheets 

The worksheet is a page of data in your spreadsheet (or workbook) that is organized by the labeled 

tabs displayed at the bottom of the Excel window. 

• Your spreadsheet can contain as many worksheets as you want. By default, however, all newly 

opened Excel spreadsheets have three worksheets. 

• To view the contents of a worksheet, click on its tab. 

 

Create or delete an Excel table in a worksheet 

A worksheet consists of cells that are organized into columns and rows; a worksheet is always 

stored in a workbook. 

The primary document that you use in Excel is to store and work with data. It is also called a 

spreadsheet.  

You can manage and analyze the data in that table independently of data outside the table 

 

Create a table 

You can use one of two ways to create a table. You can either insert a table in the default table style 

or you can format your data as a table in a style that you choose. 

 

Insert a table 

1. On a worksheet, select the range of cells that you want to include in the table. The cells can 

be empty or can contain data.  

2. On the Insert tab, in the Tables group, click Table.  

Keyboard shortcut:- You can also press CTRL+L or CTRL+T. 

3. If the selected range contains data that you want to display as table headers, select the My 

table has headers check box.  

 

Format data as a table 
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1. On the worksheet, select a range of empty cells or cells that contain the data that you want 

to quickly format as a table.  

2. On the Home tab, in the Styles group, click Format as Table.  

3. Under Light, Medium, or Dark, click the table style that you want to use.  

 

Convert a table to a range of data 

1. Click anywhere in the table.  

2. On the Design tab, in the Tools group, click Convert to Range.  

 

 

Delete a table 

 On a worksheet, select a table.  

 Press DELETE.  

 

To create a new, blank workbook: 

 Left-click the Microsoft Office Button. 

 Select New:- The New Workbook dialog box opens, and Blank Workbook is 

highlighted by default. 

 Click Create:- A new, blank workbook appears in the window. 

 

 

To insert text: 

 Left-click a cell to select it. Each rectangle in the worksheet is called a cell. As you select a 

cell, the cell address appears in the Name Box. 

 Enter text into the cell using your keyboard. The text appears in the cell and in the formula 

bar. 

Cell addresses 

Each cell has a name, or a cell address, based on the column and row where it is located. For 

example, this cell is C3 because it is where column C and row 3 intersect. 

 
 

To edit or delete text: 

 Select the cell. 

 Press the Backspace key on your keyboard to delete text and make a correction. 
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 Press the Delete key to delete the entire contents of a cell. 

To save the workbook: 

 Left-click the Microsoft Office Button. 

 Select Save or Save As. 

 Save As allows you to name the file and choose a location to save the spreadsheet. 

Choose Save As if you'd like to save the file for the first time or if you'd like to save the file 

as a different name. 

 Select Save if the file has already been named. 

Formatting Your Spreadsheet 

 Inserting Columns 

 Inserting Rows 

 Deleting Columns 

 Deleting Rows 

 Resizing Columns 

 Resizing rows 

 

Excel formatting tips and techniques:-  

There are many formatting tools some are explained below:- 

 

To format text in bold or italics: 

 Left-click a cell to select it, or drag your cursor over the text in the formula bar to select it. 

 Click the Bold or Italics command. 

 

To format text as underlined: 

 Select the cell or cells you want to format. 

 Click the drop-down arrow next to the Underline command. 

 Select the Single Underline or Double Underline option. 

 

To change the font style 

 Select the cell or cells you want to format. 

 Left-click the drop-down arrow next to the Font Style box on the Home tab. 

 Select a font style from the list. 

 

To change the font size: 

 Select the cell or cells you want to format. 

 Left-click the drop-down arrow next to the Font Size box on the Home tab. 

 Select a font size from the list. 

 

To change the text color: 

 Select the cell or cells you want to format. 

 Left-click the drop-down arrow next to the Text Color command. A color palette will 

appear. 

 Select a color from the palette. 
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Introduction to functions:- 

A function is a predefined formula that performs calculations using specific values in a 

particular order. While you may think of formulas as being short mathematical equations, like 

2+2 or F2*C2, they can actually be very lengthy and involve complex mathematical 

calculations.  

 

One of the key benefits of functions is that they can save you time because you do not have to write 

the formula yourself. For example, you could use an Excel function called Average to quickly find 

the average of a range of numbers or the Sum function to find the sum of a cell range. 

 

 

The parts of a function: 

Each function has a specific order, called syntax, which must be strictly followed for the function to 

work correctly. 

Syntax order: 

1. All functions begin with the = sign. 

2. After the = sign, define the function name (e.g., Sum). 

3. Then there will be an argument. An argument is the cell range or cell references that 

are enclosed by parentheses. If there is more than one argument, separate each by a 

comma. 

An example of a function with one argument that adds a range of cells, A3 through A9: 

 
An example of a function with more than one argument that calculates the sum of two cell ranges: 

Excel's different functions 

There are many different functions in Excel 2007. Some of the more common functions 

include: 

Statistical functions: 

SUM: Adds a range of cells together 

AVERAGE: Calculates the average of a range of cells 

COUNT: Counts the number of chosen data in a range of cells 

MAX: Identifies the largest number in a range of cells 

MIN: Identifies the smallest number in a range of cells 

Financial functions: 

Interest rates 

Loan payments 

Depreciation amounts 

Date and time functions: 

DATE: Converts a serial number to a day of the month 

Day of Week 

DAYS360: Calculates the number of days between two dates based on a 360-day year 

TIME: Returns the serial number of a particular time 

HOUR: Converts a serial number to an hour 
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MINUTE: Converts a serial number to a minute 

TODAY: Returns the serial number of today's date 

MONTH: Converts a serial number to a month 

YEAR: Converts a serial number to a year 

Chart:- 

A chart is a tool you can use in Excel to communicate your data graphically. Charts allow your 

audience to more easily see the meaning behind the numbers in the spreadsheet, and to make 

showing comparisons and trends much easier. In this lesson, you will learn how 

to insert and modify Excel charts and see how they can be an effective tool for communicating 

information. 

Creating a chart 

Charts can be a useful way to communicate data. When you insert a chart in Excel, it appears in the 

selected worksheet with the source data by default. 

To create a chart: 

 Select the cells you want to chart, including the column titles and row labels. 

 Click the Insert tab. 

 Select one of the Chart options.  

 Select a type of chart from the list that appears. The chart appears in the worksheet. 

The real power in Excel lies in its ability to perform multiple 

mathematical calculations for you. One of the tools in Excel that you can use to perform these 

calculations is a Data tool called what-if analysis also known as Goal Seek. What-if analysis allows 

you to see the effect different values have in formulas.  

 

What-If Analysis Tools 

There are three What-If analysis tools that you can use. To access these, select the Data tab and 

locate the What-If Analysis command. If you click this command, a menu with three options 

appears.  

 

Goal seek is useful if you know the needed result but need to find the input value that will give you 

the desired result. In this example, we know the desired result (a $400 monthly payment) and are 

seeking the input value (the interest rate). 

 

Goal Seek 

To Use Goal Seek to Determine an Interest Rate: 

 Select the Data tab. 
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 Locate the Data Tools group. 

 Click the What-If Analysis command. A list of three options appears. 

 
  

 Select Goal Seek. A small dialog box appears. 

 Select the cell that you want to set to a specific value. In this example, we want to set B5, 

the Payment cell. 

 
  

 Insert the cursor in the next field. 

 Enter a value in the value field. In this example, type -$400. Since we‘re making a payment 

that will be subtracted from our loan amount, we have to enter the payment as a negative 

number. 

 
  

 Insert the cursor in the next field. 
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 Select the cell that you want to change. This will be the cell that tries various input values. 

In this example, select cell B4, which is the interest rate. 

 
  

 Click OK. 

 Then, click OK again. The interest rate appears in the cell. This indicates that a 7% interest 

rate will give us a $400 a month payment on a $20,000 loan that is paid off over five years, 

or 60 months. 

 
Working with graphic:- 

Microsoft Office Excel 2007 gives you the tools to create a variety of graphic objects—boxes, lines, 

circles, ovals, arcs, freeform polygons, text boxes, buttons, and a wide assortment of complex 

predefined shapes, clip art, and the new SmartArt graphics.  

Using the Shapes tools 

The Excel graphics tool chest contains many of the powerful capabilities of dedicated illustration 

programs. Using only the tools in the Shapes palette on the Ribbon, you can create lines, rectangles, 

and ovals; smooth and freeform curves; linked objects using connectors; basic and not-so-basic 

shapes, such as pentagons and lightning bolts; a variety of straight, curved, three-dimensional (3-

D), and multiheaded arrows; stars, emblems, and banners; and even a variety of callouts. 

Creating WordArt 

The WordArt button on the Insert tab opens a palette containing a number of fancy text styles you 

can employ to create impressive logos and headings. After you click the effect you want in the 

palette, a new WordArt graphic object appears on the worksheet. You can then type your text and 

modify the WordArt object using controls on the Format tab under Drawing Tools; this tab appears 

on the Ribbon when you select the WordArt object. 
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Creating SmartArt 

The SmartArt button on the Insert tab represents a significant new set of features in the 2007 

Microsoft Office system. SmartArt replaces the Organization Chart feature with all that and more—

a comparative cornucopia of new functionality and graphic complexity. SmartArt graphics are 

prepackaged sets of graphic objects designed to address a variety of presentation tasks, such as 

creating timelines and decision trees, illustrating procedural steps and relationships, and, yes, even 

creating organizational charts. 

 

MS POWERPOINT 2007 

Microsoft Office Button: The Microsoft Office button appears in the top left corner of the window 

and includes basic file functions such as New, Open, Save, and Print.  

Tabs: The many buttons and menu options required to create and edit presentations are grouped 

into seven distinct categories and accessible from tab-like buttons which appear across the top of 

the window. 

 Ribbon: The ribbon contains the buttons and menu options specific to each tab for creating and 

editing presentations. 

 Current Slide: The current slide appears in the middle of the screen and contains the contents of a 

particular PowerPoint slide.  

Outline or Slides Tab: The Slides tab displays thumbnails of all slides in a presentation. The 

Outline tab displays an automatically generated outline of the presentation. 

 Help button: The help button in the top right corner of the window provides access to an index of 

help topics as well as a key-word search of the extensive help files.  

 

 
Lower Toolbar: The lower toolbar allows easy toggling between viewing options and also displays 

the number of the slide currently on screen.  

 
 

Tabs and the Ribbon 
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The ribbon includes seven tabs to choose from. After selecting a tab, the ribbon will automatically 

update to display the appropriate menu options and buttons. The menu options and buttons are 

grouped by functional category into distinct toolbars. 

 More Options button to display a pop-up window with the full set of menu options and buttons for 

that category. The More Options button is square-shaped with an arrow.  

 
Home Tab 

The Home tab includes basic functions for creating and manipulating a presentation. The toolbars 

that make up the Home tab include Clipboard, Slides, Font, Paragraph, Drawing, and Editing. 

Example menu and button options include copying and pasting, adding a new slide, adjusting fonts 

and paragraph formatting, and basic drawing features. 

 
Insert Tab 

Use the Insert tab to add a wide variety of content into a presentation including tables, charts, 

images, links, text boxes, audio, and video. The toolbars that make up the Insert tab include Tables, 

Illustrations, Links, Text, and Media Clips. 

 
Design Tab 

The Design tab provides a variety of options for designing and formatting a presentation. Use the 

Design tab to manipulate the page setup, color themes, and backgrounds of a presentation. The 

toolbars that make up the Design tab include Page Setup, Themes, and Background. 

 
Animations Tab 

Use the Animations tab to add, customize, and preview animations and transitions between slides. 

The toolbars that make up the Animations tab include Preview, Animations, and Transition to This 

Slide. 
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Slide Show Tab 

Manage the settings for showing a presentation with the Slide Show tab. The toolbars that make up 

the Slide Show tab include Start Slide Show, Set Up, and Monitors. 

 
 

Review Tab 

The Review tab provides access to proofing features like spell check and also allows for embedding 

comments in a presentation. The toolbars that make up the Review tab include Proofing and 

Comments. 

 
 

View Tab 

The View tab presents a number of options to specify how to view a presentation such as hiding or 

displaying notes, hiding or displaying gridlines, zooming in and out, displaying in gray scale, and 

more. The toolbars that make up the View tab include Presentation Views, Show/Hide, Zoom, 

Color/Grayscale, Window, and Macros. 

 
 

Create a New Presentation 

To create a new presentation, 

 Click the Microsoft Office button and select New. The New Presentation pop-up window 

will appear, 

Choose to start with one of Microsoft‘s Installed Templates, Installed Themes, or a Blank 

presentation to create a customized presentation.  

 Click the Installed Themes menu option to browse through the available graphical themes. 

Select one that will work for the presentation.  
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 Click the Create button in the lower right-hand corner.  

Or 

To create a completely custom-designed presentation,  

 Select the Blank and recent menu option.  

 Click the Blank Presentation button and then the Create button in the lower right-hand 

corner.  

 
 

 

Design a Presentation 

PowerPoint includes a number of ready-made design themes. These themes serve as the basis for 

the graphic design of a presentation. Each theme consists of a background design, placeholder 

layouts, a color palette, and font styles. To browse through the available themes, click the Design 

tab in the ribbon.. Click a particular theme to apply it to the presentation. 

 

 
To skip the ready-made themes in order to create a custom-designed presentation, 

 Select the Design tab in the ribbon.  

 Click the Background Styles menu to choose the background.  

 Click the Colors, Fonts, and Effects menus in the Themes toolbar to customize the design of 

the presentation.  

 To customize a ready-made theme, click an element within a slide.  

 Select the Design tab and then choose from the various options available from the Colors, 

Fonts, and Effects menus in the Themes toolbar.  

 Adjust the Background using the Background Styles menu in the Background toolbar. 

Insert a New Slide 

To insert a new slide into a presentation,  

 Click the Home tab in the ribbon.  

 In the Slides toolbar, select the New Slide button  
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Save the Presentation 

To save a presentation,  

Click the Microsoft Office button and choose Save As.  

 

Charts 

Charts and graphs are an effective way to present information than a simple list of numbers. 

PowerPoint 2007 is fully integrated with the spreadsheet tools of Excel 2007, making it very easy to 

create a chart from scratch or to import data from an existing spreadsheet. 

 

Creating Charts 

1. Select the slide where you want the chart to appear. 

2. In the Insert tab, under the Illustrations group, click on CHART  to open the Insert 

Chart dialog. 

 
3. Select the type of chart from the category list on the left, or simply scroll through the gallery 

on the right to view all the available charts. Once you have made your selection, click OK. 

4. The chart will appear on your slide, and Excel will open as a split screen with dummy data 

already filled in. 

5. Add your data and labels to the Excel spreadsheet and the chart will be automatically 

updated on your slide. 

6. When finished, click the  in the upper right hand corner of Excel to close the worksheet.. 
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Animation  
PowerPoint allows you to animate objects or specific content within a slide and also to add 

animated transitions between slides. Transitions are a common and easy way to liven up a 

presentation.  

 

Add Transitions  
To add a consistent transition between each slide throughout the presentation, follow these 

instructions.  

1. Click the View tab and click the Slide Master button.  

2. In the left-hand Slides tab, select the first slide which is numbered ―1.‖  

3. Click the Animations tab.  

4. In the Transition to This Slide toolbar, browse through the transition options and click the 

appropriate choice. Place the mouse over each option to preview the transition within the slide 

currently on screen.  

5. When satisfied with the transition, click the Slide Master tab and then the Close Master View 

button.  

 
 

Add Animation  
With PowerPoint, you can animate virtually any object or specific content that appears on a slide.  

 To animate an object or content, select it.  

 Click the Animations tab.  

 Select from the menus and buttons available in the Animations toolbar.  

 After selecting the appropriate animation settings, use the Preview button to see the 

animation in. 

 

Audio  

 To add audio to a presentation 

1. Click the Insert tab.  

2. Then click the Sound button.  

3. Navigate to the correct audio clip and select it.  

4. A pop-up window will ask if the audio should play Automatically or When Clicked.  

5. An audio icon will automatically appear on the slide. To preview the audio, right click the audio 

icon and select    Preview.  

 

Inserting and Format Picture Tab:- 

You can even insert the image in your presentation. To insert click on insert option and then on 

picture, a window will open you can insert the picture from any desired location. 

After you insert an image the Picture Tools - Format tab will automatically appear.  

Adjust Picture Settings 
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The Adjust group on the Picture Tools tab allows you to adjust 

the brightness and contrast of your image. You can also use 

the recoloring options to change the tint of your picture. 

 

Borders and Effects 

 
With the Picture Styles group you can add some interesting effects to your images, including 

regular borders and shaped borders, shadows and reflections, and 3-D rotation options. PowerPoint 

comes with a number of built-in options, or you can customize your own using the drop down 

Picture Shape, Picture Border, and Picture Effects menus on the right. 

Arranging, Aligning & Grouping Images 

Arranging 
PowerPoint allows you to overlap objects, so that for example you 

could have a text box or a callout over an image, or two images that 

overlap each other, or several solid shapes and lines arranged to make 

an interesting background on a slide master. 

Aligning 
You can always move objects by clicking and dragging them, 

but if you want to be more exact with your placement, use the 

options under the Align menu. You can use this to place 

objects to the right, left, top, bottom, and center of the slide, make 

sure the object is both horizontally or vertically centered by 

using the distribute options, or display a grid to help with your 

manual placements. 

Grouping 
The final option in the Arrange section is the Group button. 

This button is used to combine objects into one so that they 

can be moved and edited all at once.  

Cropping & Resizing Images 
You can also use the Crop tool to remove unnecessary parts of your images. Cropping resizes an 

image by hiding horizontal or vertical edges. 

To crop an image, click the Crop button.  

 

Inserting animated pictures 

1. On the Insert menu, point to Movies and Sounds, click Movie from File, locate the folder that 

contains the file you want, and then double-click the file. 

(A movie or .gif file that you've added to Clip Organizer is found in the Clip Organizer folder 

within the My Pictures folder on your hard disk. Or, go to the original location for these files.) 

2. When a message is displayed, do one of the following: 

 To play the movie or GIF automatically when you go to the slide, click automatically. 

 To play the movie or GIF only when you click it, click When Clicked. 

 

javascript:AppendPopup(this,'727122714_2')
http://gethelp.library.upenn.edu/images/workshops/biomed/ppt/pictools_rotate.gif
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Inserting Sounds:   

PowerPoint 2007 provides some videos and sound clips that are free to use in the Clip Manager. 

You can also use clips from other sources, such as the Web, a CD of sound effects, or sounds you 

create yourself. 

You can insert sound using following:- 

 Inserting sounds using the Clip Organizer 

 Inserting sounds from a file 

 Recording your own sounds 

 

Adding Notes 

There are two ways to insert notes in PowerPoint. 

1. To insert short notes: In the Normal view, click on the Notes box at the bottom of your screen 

and type your text. 

 

2. To insert longer notes: Click on the View tab. Under Presentation Views select the Notes 

Page button. Type your notes in the space that appears below your slide. 

 

  

Inserting Headers & Footers 

 

To add a header and footer, click on the Insert tab, then on the Header & Footer button. The Date 

& Time and Slide Number buttons will bring up the same dialog box. 

 
1. Fixed and Automatic Dates - PowerPoint gives you the option to add either a fixed date and 

time, which will remain the same, or a date and time that automatically update. If you choose to 

have a date and time that automatically update, the date and time will always match the date and 

time that you run your slide show. 

2. Slide Number - Check this box to show the slide number. 

3. Footer - Check the Footer box and add text to have text appear at the bottom of the slide. 

4. Apply/Apply To All - To insert your chosen elements into your slide, select Apply to have the 

information appear only on your current slide, or Apply To All to have it appear on every slide. If 

any of the information is repeated on the title slide, check the Don't show on title slide box to 

avoid repeating the information. 
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5. Preview - The Preview box shows you where on your slide the information will appear. You can 

not change this from within this screen, but once you insert the information you can click and drag 

the box anywhere in your slide, just like any other text box. 

Note: If you chose to Apply To All, moving the text box in one slide will not effect the placement of 

the information in the rest of your slides. 

6. Notes and Handouts - Under this tab, you can choose your header and footer preferences for 

your handouts. 

 

WordArt overview 

WordArt allows you to add special text effects to your document. For example, you can stretch a 

title, skew text, make text fit a preset shape, or apply a gradient fill. This WordArt becomes an 

object that you can move or position in your document to add decoration or emphasis. You can 

modify or add to the text in an existing  

WordArt object whenever you want. 

 

 
Layering Art Objects:- 

There are two main reasons you may want to layer objects in a PowerPoint presentation. 

1. Layering objects gives you the freedom to arrange your presentation the way we 

want it to look. 

2. Layering lets you take advantage of all of the white space in your presentation. Text 

boxes in particular take up a lot of room. By layering objects, you can use all of the 

space on a slide without changing the position of other objects. 

Layering Objects in PowerPoint 

Suppose you add four boxes to your PowerPoint presentation; first a red one, then green, then blue, 

then yellow. Each box represents an object. When you add a new object to a PowerPoint 

presentation, the application automatically places the newest objects on top of older objects. If you 

add the boxes in the order mentioned above, the layering of the objects will look like this: 
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In the Drawing section, locate and click on the button titled Arrange to arrange it according to 

you. 

 
There are four options titled: 

1. Bring to Front 

2. Send to Back 

3. Bring Forward 

4. Send Backward 

 

 

 

 

 

 

 



 
B.Com 1st Sem.        Subject- Introduction to Computer Fundamental and PC 
Software 
 

 

45, Anurag Nagar, Behind Press Complex, Indore (M.P.) Ph.: 4262100, www.rccmindore.com 
81 

 

UNIT IV 

Decision Support System 

Types of Decision:  

1. Structured or programmable Decision- A decision can be programmed, if it follows decision 

rule, decision procedure or specified sequence of activity is performed [Algorithm]. This can be 

expressed as a flowchart, a decision table or a formula. The decision procedure will also specify 

the information to be acquired before the decision can be pre-specified; many of these decisions 

can be handled by lower-level personnel with little specialized knowledge. For example, 

inventory recording decision or the decision rule for granting credit. 

   The important characteristics of programmed decision are- 

 These decisions can be delegated. 

 The cost of taking such decision is not as high as that of non-programmed once. 

 These decisions can be made with the help of computer systems. 

 

2. Non-programmed or unstructured decision- This type of decision is occasional and unique in 

nature. There are no predefined procedures available to solve these problems and a new analysis 

is required for each occurrence. Production scheduling, advertising budget, taking of capital 

projects i.e., capital executives have to make use of problem-solving methodology, which itself 

depends on subjective human judgments. The risk involved in taking decision to solve the 

problems in this manner is usually high. The important feature of non-programmed decision are: 

           These decisions cannot be delegated. 

The best of taking decision in comparison with programmed decision is quite high. 

3. Semi-structured- Semi structured decisions are such type of decision procedures that can be 

pre-specified, but not enough to lead to a definite recommended decision. 

 

Decision Making 

Decision making is a cognitive process that results in the selection of a course of action among 

several alternative scenarios. Decision making is a daily activity for any human being. There is no 

exception about that. When it comes to business organizations, decision making is a habit and a 

process as well. Effective and successful decisions make profit to the company and unsuccessful 

ones make losses. Therefore, corporate decision making process is the most critical process in any 

organization. In the decision making process, we choose one course of action from a few possible 

alternatives. In the process of decision making, we may use many tools, techniques and perceptions. 

In addition, we may make our own private decisions or may prefer a collective decision. Usually, 

decision making is hard. Majority of corporate decisions involve some level of dissatisfaction or 

conflict with another party. 
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Decision Making Process: 

Following are the important steps of the decision making process. Each step may be supported by 

different tools and techniques. 
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Process and Modeling in Decision Making 

There are two basic models in decision making: 

 Rational models 

 Normative model 
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Dimensions and characteristics of managerial decision making: 

 it is sequential in nature 

 it is exceedingly complex due to risks and trade offs 

 managerial decisions are influenced by personal values 

 

Decision Support system (DSS)  

 The decision support system is an interactive computer based system, which helps decision-

makers to utilize data and models to solve unstructured problems. The DSS is designed to facilitate 

the solutions of problem of structured than those of MIS and TPS which are less structured. The 

nature of decision taken by DSS is of non-routine and less structured. The DSS is a collection of 

data and data processing tools used to creatively manipulate data to answer unknown and often 

unexpected questions. DSS is a coordinated collection off data, system, tools and techniques with 

the necessary, S/W and computer H/w through which an organization gathers and interprets 

relevant information from the business and environment and turns into information that acted upon. 

In the end, we can say that- DSS aims at supporting the decision maker by providing the 

information with the aid of quantitative techniques. 

DSS provides varying analysis without much programming effort and is usually directed towards 

non-technical users/managers. Managers main uses for a DSS includes searching, retrieving and 

analyzing decision relevant data to allow them to summarize main points which assist them in 

making more informed and educated decisions. Users often search for correlations between data 

without rewriting the underlying MIS or software application and most DSS allows graphic 

capabilities, which not only allows trend analysis and reporting for top executives, but also assists 

managers in mapping out conjoint analysis and alternative scenarios to answer ―what if‖ queries. 

Consequently, DSS supports both tactical and strategic decisions and are employed to leverage 

manager‘s expertise in a certain field 

Attributes of a DSS 

 Adaptability and flexibility 

 High level of Interactivity 

 Ease of use 

 Efficiency and effectiveness 

 Complete control by decision-makers. 

 Ease of development 

 Extendibility 

 Support for modeling and analysis 

 Support for data access 

 Standalone, integrated and Web-based 
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Characteristics of a DSS 

 Support for decision makers in semi structured and unstructured problems. 

 Support for managers at various managerial levels, ranging from top executive to line 

managers. 

 Support for individuals and groups. Less structured problems often requires the involvement 

of several individuals from different departments and organization level. 

 Support for interdependent or sequential decisions. 

 Support for intelligence, design, choice, and implementation. 

 Support for variety of decision processes and styles 

 DSSs are adaptive over time. 

 

Applications of D.S.S 

The applications of DSS are as follows- 

1. An airline DSS –developed by American Airlines but is used by other airlines, aircraft 

manufacturers and airlines financial analysis consultants and associations.  

2. A Marketing DSS – BRAND AID is used for marketing planning, especially in the packaged 

goods industries. It helps brand managers to make pricing, sales effort, promotion, advertising and 

budgeting decision for products, product line and brand of products. 

3. Government DSS- GADS (Geodata-Analysis and Display System) was develo9ped by IBM. It 

constructs and displays maps and other graphics display that support decisions affecting the 

geographic distribution of people and other resources. 

 4.  Banking DSS-MAPP (Managerial analysis for profit planning) is a DSS developed by citi-bank. 

It was designed to support decisions involved in the financial planning, budgeting costing and 

pricing of bank products, It helps bank executives define banking products and services, It also 

helps to determine, how resources should be shifted among bank products and services and it 

prepares budgets for the bank department producing each banking product. 

Many types of Decision Support Systems 

As mentioned earlier, DSS can be classified in many different categories. Amongst the common 

ones are the following: 

2.1 Data driven DSS 

These DSS has file drawer systems, data analysis systems, analysis information systems, data 

warehousing and emphasizes access to and manipulation of large databases of structured data 
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2.2 Model driven 

The underlying model that drives the DSS can come from various disciplines or areas of specialty 

and might include accounting models, financial models, representation models, optimization 

models, etc. With model drive DSS the emphasize is on access to and manipulation of a model, 

rather than data, i.e. it uses data and parameters to aid decision makers in analyzing a situation. 

These systems usually are not data intensive and consequently are not linked to very large 

databases. 

2.3 Knowledge driven 

These systems provide recommendation and/or suggestion schemes which aid the user in selecting 

an appropriate alternative to a problem at hand. Knowledge driven DSS are often referred to as 

management expert systems or intelligent decision support systems. They focuses on knowledge 

and recommends actions to managers based on an analysis of a certain knowledge base. Moreover, 

it has special problem solving expertise and are closely related to data mining i.e. sifting through 

large amounts of data to produce contend relationships. 

 2.4 Document driven 

These systems help managers retrieve and mange unstructured documents and web pages by 

integrating a variety of storage and processing technologies to provide complete document retrieval 

and analysis. It also access documents such as company policies and procedures, product 

specification, catalogs, corporate historical documents, minutes of meetings, important 

correspondence, corporate records, etc. and are usually driven by a task-specific search engine.2 

 2.5 Communication driven 

This breed of DSS is often called group decision support systems (GDSS). They are a special type 

of hybrid DSS that emphasizes the use of communications and decision models intended to 

facilitate the solution of problems by decision makers working together as a group. GDSS supports 

electronic communication, scheduling, document sharing and other group productivity and decision 

enhancing activities and involves technologies such as two-way interactive video, bulletin boards, 

e-mail, etc. 

 2.6 Inter- and Intra-organization DSS 

These systems are driven by the rapid growth of Internet and other networking technologies such as 

broadband WAN‘s, LAN‘s, WIP, etc. Inter-organization DSS are used to serve companies 

stakeholders (customers, suppliers, etc.), whereas intra-organization DSS are more directed towards 
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individuals inside the company and specific user groups. The latter, because of their stricter control, 

are often stand-alone units inside the firm. 

  

2.7 New breeds of DSS 

 Hybrid Systems, which are combinations units using aspects of more than one different type 

of DSS. A very popular example is Web based DSS, which can be driven by a combination 

of different models such as document-driven, communication driven and knowledge drive. 

Web-based DSS are computerized systems that delivers decision support information or 

decision support tools to a manager or business analyst using a "thin-client" Web browser 

like Netscape Navigator or Internet Explorer.18 

 On-line Analytical Processing (OLAP) - a category of software technology that enables 

analysts, managers and executives to gain insight into data through fast, consistent, 

interactive access to a wide variety of possible views of information that has been 

transformed from raw data to reflect the real dimensionality of the enterprise as understood 

by the user.16 

 Designed for managers looking to make sense of their information, OLAP tools structure 

data hierarchically – the way managers think of their enterprises, but also allows business 

analysts to rotate that data, changing the relationships to get more detailed insight into 

corporate information.17 

 OLAP and web-based Decision Support Systems are by far the more popular Decision 

Support Systems these days. Their definition and functionality extends far beyond the scope 

of this paper and consequently we will not explore these systems in detail. Many other 

Decision Support Systems are on the market today, but to explore all of them would, for 

now, be a farcical objective. 

 Keeping the various distinctions and classifications of DSS in mind, a DSS should be described in 

terms of: 

 The dominant technology component or model underlying the system 

 Targeted users 

 Specific purpose 

 Primary deployment of technology (mainframe, client/server LAN, web-based) 

An example: a management team might want a document-driven, inter-organizational, 

product design, web-based DSS 
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Architecture of DSS 

  

Data from the organizations, TPS and MIS 

applications are input to the DSS programs, 

along with data from external sources and 

DSS model data. As stated, the DSS may 

store and later reprocess its own model data 

as well. The user interacts with the DSS 

online, requests are made, models are created 

or adjusted and data is manipulated etc. The 

outputs of the DSS program can be either 

text, structured reports or graphics. A variety 

of programs supported by the DSS include 

spreadsheet programs, personal data base 

management systems, model base 

management systems, word processing 

packages and other special purpose programs.  

 

 

 

 

 

 

 

 

 

 

 

Benefits of DSS 

 Improves efficiency and speed of decision making activities 

 Increases the control, competitiveness and capability of futuristic decision making of the 

organization 

 Facilitates interpersonal communication 

 Encourages learning or training 

 Since it is mostly used in non-programmed decisions, it reveals new approaches and sets up 

new evidences for an unusual decision 

 Helps automate managerial processes 

 

Components of a DSS 

Following are the components of the Decision Support System: 

Database Management System (DBMS): To solve a problem the necessary data may come from 

internal or external database. In an organization, internal data are generated by a system such as 

TPS and MIS. External data come from a variety of sources such as newspapers, online data 

services, databases (financial, marketing, human resources). 

 

DSS 

Models 

DSS 

Programs 

DSS 

Users 

External 
Data 

Graphs Report
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Model Management system: It stores and accesses models that managers use to make decisions. 

Such models are used for designing manufacturing facility, analyzing the financial health of an 

organization. Forecasting demand of a product or service etc 

Support Tools: Support tools like online help; pull down menus, user interfaces, graphical analysis, 

error correction mechanism, facilitates the user interactions with the system. 

Classification of DSS 

There are several ways to classify DSS. Hoi Apple and Whinstone classify DSS in following: 

 

 Text Oriented DSS 

 Database Oriented DSS 

 Spreadsheet Oriented DSS 

 Solver Oriented DSS 

 Rules Oriented DSS 

 Rules Oriented DSS 

 Compound DSS
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The tools of decision support systems 

Decision support system‘s tools are programs or codes which are the foundation used to create 

the generations and in turn specific DSS. 

Decision support tools may involve the following:- 

(a) Material requirement planning (MRP) – MRP is a method for ordering and 

maintaining materials in stock. It is a systematic approach to identify cost-beneficial 

ways of storing materials. 

(b) Linear programming – Linear programming assists in solving problems which involves 

allocation off limited resources and evaluation of alternatives to achieve objectives. 

(c) Queuing theory – Queuing theory is used in planning the activities of the organization to 

determine economically beneficial queues e.g. production of goods. 

(d) Descriptive statistics- Descriptive statistics are used to estimate parameter and the 

dispersion of values associated with that parameter. These estimates are made for the 

various critical environmental factors to plan the day-to-day operations of the 

organizations. 

(e) Correlation analysis- Correlation analysis is made to calculate relationship between 

values for particular parameters, such parameters value describing current conditions. 

(f) Variance analysis- Variance analysis is used to describe variance between two or more 

variables. 

(g) Network analysis- Network analysis is a pictorial tool for identifying and sequencing 

tasks. Those analysis help manager in controlling tasks necessary for successful operation 

of organization. 

(h) Transportation problems- Transportation problems are used for planning and 

distribution of various facilities and resources. 

(i) Maximum flow or distance – Program flow or distance is a tools for identifying the 

most economically beneficial flow through, or distances between, particular objects, this 

facilitates in determining the most preferred flow of goods or services through an object 

for which the organization must conduct business. 

(j) Dynamic programming – Dynamic programming is a tool to enable that appropriate 

course of action and top level management are being followed by managers at operational 

level. 

(k) Regression analysis- The regression analysis can be used to estimate particular values on 

the basis of known values for variables. It may be used to estimate the value of known 

variables which may influence plans for implementing the decision of top level 

managers. 

(l) Markov processes – Markov processes are tools used to determine global associated 

with the occurrences of the related to changing probabilities of particular object. These 
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global probabilities can then be used to determine more appropriate courses of action for 

the organization. 

 

Users of Decision Support System: 

The ultimate user of a decision support system is the decision maker; however, he may not 

actually run the system. Based on his research on Decision Support Systems, Alter identified 

following four distinct usage patterns. 

1. Terminal mode 

2. Clerk mode 

3. Subscription mode 

4. Intermediary mode. 

1. Terminal mode: 

The decision maker is the direct user of the system through on line access. 

2. Clerk mode: 

The decision maker uses the system directly but offline, preparing input on a coding form. The 

primary difference between this mode and the terminal mode is in the technology employed 

(batch versus online). 

3. Subscription mode: 

The decision maker receives reports that are generated automatically on a regular basis. This is 

the typical mode of usage for management reporting systems. Although some data analysis 

systems or accounting models might be used in this way, it is not typical for decision support 

systems. 

4. Intermediary mode: 

The decision maker uses the system through intermediaries, who perform the analysis and 

interpret and report the results. The decision maker does not need to know the intermediary used 

the system to arrive at the requested information. 

The role of an intermediary is common in the use of decision support systems and merits 

separate attention. It has typically been argued that decision support systems will be resisted 

because managers will refuse to use terminals. The job of chief executives is highly fragmented 

with frequent interruptions. 

Such a pattern of activity is a major constraint on the use of a system requiring concentration 

over a period of time. The use of an intermediary allows the manager to benefit from the decision 

support system without actually having to execute it. 
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There are two types of intermediaries that reflect different types of support for the manager. 

(a) Expert tool user 

(b) Staff assistant or staff analyst. 

(a) Expert tool user: 
This person is skilled in the application of one or more types of specialised problem solving 

tools. The expert tool user performs tasks which the problem solver does not have the skills or 

training to perform. 

(b) Staff assistant or staff analyst: 
This person has specialized knowledge about problems and some experience with the decision 

support technology. The staff assistant essentially extends the manager‘s capabilities by taking 

over many of the tasks of problem solving such as setting up the problem, obtaining data and 

building the initial model. 

The manager can concentrate on the more unstructured portions of the problem solving task. The 

staff assistant performs work the manager could do if time were available. 

Although more intermediaries are staff assistants, there is also frequent need for the expert tool 

user. The use of intermediaries permits the systems to be more sophisticated and powerful. On 

line, interactive systems are still desirable with intermediaries because they allow them to work 

more quickly and efficiently. 

 

INTRODUCTION TO MIS 
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Definition of MIS 

A system that collects, process, stores the data and distributes information to help in decision 

making for managerial function. It is also defined as the integrated user machine system for 

providing information to supports the decision making operations & achieving organizational 

goal. 

According to Jerome ―A system that aids management in making, carrying out and controlling 

decisions‖. 

According to Kelley, ―A combination of human and computer based resources which results in 

collection, storage, retrieval, communication and use of efficient management of operations and 

for business planning‖. 

 

Right InformationTo the right person At the right placeAt the right time In the right 

formAt the right cost 

       

    

 

Management:- Management covers the planning, control and administration of the 

operations of a concern. 

Information:- Information, in MIS, means the processed data that helps the management 

in planning, controlling and operations. 

System:- data is processed into information with the help of a system. 

Need of MIS 

MIS helps the management at various levels and it is mean of communication where data are 

collected, processed, stored and retrieved for making decisions regarding planning, operation and 

control of an organization.  

MIS 

Management Information System 
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Characteristics of MIS 

 Management Oriented   

 Management Directed    

 Integrated System   

 Avoid Redundancy   

 Common Data Flow   

 Heavy Planning Element   

 Subsystem Concept   

 Common Database   

 Flexibility   

 Computerization 
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Components of MIS 

Management information system refers to the data, hardware and the computer programs that are 

used to develop information for managerial use.  

 People – it is the only living component of MIS which operates, controls the other 

components of MIS.  

 Procedure – procedure explain people how to operate the computer hardware. 

 Data – Data provide interface between the user and computer. 

 Hardware – It is the machine part of the system which executes the instruction in 

programs. 

 Programs – The program is the set of instruction written in logical order for performing 

specific task related to information production. 

 

Function of MIS 

It is used to collect the data and present the information to the managers. MIS is the combination 

of computer and procedures for providing information that manager‘s use in making decision. 

 Collect Data – Data can be obtained from sources within organization and outside world.  

 Store & Process Data – After creation of the data, a database must be stored and process 

in the form useful to manager‘s data is generally stored to CD ROM or hard disk.  

 Present Information to Managers – After collection, storing and processing of data, the 

next step is to present information to the managers. 

 Retrieval of Information 

 

Role of MIS 

1 MIS ensure that appropriate and relevant data is collected from various sources, processed and 

is sent further to the needy destination. 

2 It fulfills the need of individual, workgroup and management. 

3. MIS satisfies the diverse need of various systems like query, Analysis, Modeling, DSS. 

4 MIS helps in strategic planning, management control, operational control and transaction 

processing level. 

5 MIS play important role in information generation, communication, problem identification and 

decision making administration. 
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6 With good MIS support marketing, finance, production, and personal functions increases 

efficiently. 

7 MIS helps in streamlining of the operations. 

8 MIS creates structured database and therefore saves the time. 

9 MIS bring clarity in communication and understanding this help in bringing high degree of 

professionalism. 

10 MIS helps in systemization of business operation through tools and techniques of the 

computer, which makes task simpler, accurate and faster. 

Application of MIS in different business areas 
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There are two basic approaches for development of MIS: 

a) System development life cycle: The system development life cycle have following steps of 

development: 

i) Systems Planning 

ii) Systems Analysis 

iii) Systems Design 

iv) Systems Implementation 

v) Systems Operation and Support (System Maintenance)  
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Waterfall model 

Spiral Model 

Agile  

b) Prototyping: Prototyping is the process of creating an incomplete model of the future full-

featured system, which can be used to let the users have a first idea of the completed program or 

allow the clients to evaluate the program. 

Process of MIS 

The process of MIS starts by knowing MIS objectives. The objectives of MIS should be 

compatible with the company‘s objectives.  

Management comprises process or activities they are as follows:- 

1. Recognition of a problem and an opportunity 

2. Define problem or opportunity 

3. Develop alternative course of action 

4. Decision 

5. Implementation of plan 

6. Control performance against plan 

 

For its smooth functioning and achieving of its predetermined goals through optimal utilization 

of its resources like men, money, material and machines. 
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INTERNET – IMPORTANT TERMS/FACTS:- 

Define internet 

Introduction: - the internet is a global network of interconnected computers, enabling users to 

share information along multiple channels. Typically a computer that connects to the internet can 

access information from a vast array of available servers and other computers by moving 

information from them to the computer‘s local memory. 

From a social point of view – the internet is a device through which millions of people are 

communicating and sharing their idea and information. 

From a technical point of view – the internet is a network of thousands of computer networks. 

Together the networks making up the internet consist of over million computer systems. 

Growth of internet: - internet started as a government project in the US, has spread all across the 

world connecting thousands of networks and millions of people Is an amazing truth today. The 

growth of internet can be estimated by the fact that users on internet were only 124 millions in 

2000 while it increased to 175 millions in 2004 only in the United States. The current internet 

subscriber base in India is 3.3 millions. 

Owner of internet: - the internet has no president nor has it a CEO the ultimate authority on the 

internet is the internet society, which is a voluntary membership organization whose purpose is 

to promote global information exchange through the internet technology.  

Application of internet:-  

1. Business on internet 

2. Governance on/through internet 

3. Crime on internet 

4. Educational training 

5. Research  

Advantages of internet: 

1. Information 

2. Entertainment 

3. Services 

4. News 

5. E-commerce 

6. Communication 

7. Formation of communities 
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Disadvantages: 

1. Spamming 

2. Theft of personal details 

3. Pornography 

4. Virus threat 

5. Waste of time and money 

 

Internet Based Services: 

Some of the basic services available to Internet users are: 

    Email: A fast, easy, and inexpensive way to communicate with other Internet users around the 

world. 

    Telnet: Allows a user to log into a remote computer as though it were a local system. 

FTP: Allows a user to transfer virtually every kind of file that can be stored on a computer from 

one Internet-connected computer to another. 

File Transfer Protocol (FTP) 

FTP is used to copy files from one host to another. It is used to exchange and manipulate files 

over as TCP computer network, such as the internet. An FTP client may connect to an FTP 

server to manipulate files on that server. 

FTP offers the mechanism for the same in following manner: 

 FTP creates two processes such as Control Process and Da ta Transfer Process at both 

ends i.e. at client as well as at server. 

 FTP establishes two different connections: one is for data transfer and other is for control 

information. 

 Control connection is made between control processes while Data Connection is made 

between<="" b="" style="box-sizing: border-box;"> 

 FTP uses port 21 for the control connection and Port 20 for the data connection. 
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Working with FTP: -  

Working: - when you want to copy files between two computers that are on the same local 

network , often you can simply share a drive or folder , and copy the files the same way you 

would copy files from one place to another on your own PC. Transfer files from a client 

computer to a server computer are called uploading and transferring a server to a client is 

downloading. 

FTP and internet connection: - FTP uses one connection for commands and the other for sending 

and receiving data. FTP has a standard port number on which the FTP server listen for 

connection. 

Active and passive connection mode:- the ftp server may support active or passive connections 

or both. In an active ftp connection , the client opens a port and listens and the server actively 

connects to it. In a passive ftp connection , the server opens a port and listens(passively) and the 

client connect to it. 

Transmission control Protocol/Internet Protocol [TCP/IP] It is actually a collection of 

protocols that govern the way data travel from one computer to another across networks. A user 

connected on any network on the Internet can communicate with people or software located on 

any other network connected to the internet using this common set of protocols. On the internet, 

the protocol that permits two internet connected computers to establish a reliable connection is 

called TCP/IP 
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Usenet news: A distributed bulletin board that offers a combination news and discussion service 

on thousands of topics. 

A Usenet newsgroup is a repository usually within the Usenet system, for messages posted from 

many users in different locations using Internet. Despite the name, newsgroups are discussion 

groups, and are not devoted to publishing news, but were when the internet was young. 

 

World Wide Web (WWW): A hypertext interface to Internet information resources. 

WWW- This stands for World Wide Web. A technical definition of the World Wide Web is : all 

the resources and users on the Internet that are using the Hypertext Transfer Protocol (HTTP).A 

broader definition comes from the organization that Web inventor Tim Berners-Lee helped 

found, the World Wide Web Consortium (W3C): 

The World Wide Web is the universe of network-accessible information; an embodiment of 

human knowledge. In simple terms, The World Wide Web is a way of exchanging information 

between computers on the Internet, tying them together into a vast collection of interactive 

multimedia resources. 
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World wide web is a series of servers that are interconnected through hypertext. Tim burner lee 

is widely known as the father of the world wide web . burners was working with the European 

organization for nuclear research(CERN), in Switzerland).  

URL (Uniform resource locator) :-  URL is a type of uniform resource identifier that specifies 

where an identified resource is available and the mechanism for retrieving it. 

There are several parts to a URL. The first part of a URL defines a web protocol, such as the 

hypertext transfer protocol (HTTP), this part of URL (eg http://) allows the machines to talk to 

one another , the complete URL specifies the name of a server or a path to a web resource on a 

server, which a user can access by using browsers like Firefox, Opera , and Internet Explorer.  

 

2. Hyper Text Transfer Protocol (HTTP) - This stands for Hyper Text Transfer Protocol. This 

is the protocol being used to transfer hypertext documents thats makes the World Wide possible. 

Hyper Text Transfer Protocol [HTTP] HTTP is an internet standard or set of rules that allows the 

exchange of information on the World Wide Web. Hypertext is a method of preparing and 

publishing text, ideally suited to the computer, in which users can select their own text. To 

prepare hypertext, the whole material should be divided into small segments such as single pages 

of text. These small segments are called nodes. Then hyperlinks are embedded in the text. When 

the user clicks on a hyper link, the hypertext software displays a different node. The process of 

navigating among the nodes linked in this way is called browsing. A collection of nodes that are 

interconnected by hyperlinks is called a web. A Hypertext is prepared using Hyper Text Markup 

Language [HTML].The html codes are used to create links. Http is also based on the 

client/server principle. It allows the client computer to contact with server computer and make a 

request. The server accepts the connection requested by the client and sends back a response. An 

Http request identifies the information or text that the client is needed and it tells the server to 

supply the text. A standard web address such as http://www.yahoo.com/ is called a URL and here 

the prefix http indicates its protocol 

3.URL- URL stands for Uniform Resource Locator, and is used to specify addresses on the 

World Wide Web. A URL is the fundamental network identification for any resource connected 

to the web (e.g., hypertext pages, images, and sound files). 

A URL will have the following format: protocol://hostname/other_information 
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The protocol specifies how information from the link is transferred. The protocol used for web 

resources is Hypertext Transfer Protocol (HTTP). Other protocols compatible with most web 

browsers include FTP, telnet, newsgroups, and Gopher. The protocol is followed by a colon, two 

slashes, and then the domain name. The domain name is the computer on which the resource is 

located. 

Links to particular files or subdirectories may be further specified after the domain name. The 

directory names are separated by single forward slashes. 

4. WEBSITE - Currently you are on our website http://www.tutorialspoint.com which is a 

collection of various pages written in HTML markup language. This is a location on the web 

where people can find tutorials on latest technologies. Similar way there are millions of websites 

available on the web. 

Each page available on the Website is called a web page and first page of any web site is called 

home page for that site. 

5. WEB SERVER - Every Web site sits on a computer known as a Web server. This server is 

always connected to the internet. Every Web server that is connected to the Internet is given a 

unique address made up of a series of four numbers between 0 and 256 separated by periods. for 

example, 68.178.157.132 to 68.122.35.127. 

When you register a Web address, also known as a domain name, such as tutorialspoint.com you 

have to specify the IP address of the Web server that will host the site. 

6.WEB BROWSER - Web Browsers are software installed on your PC. To access the Web you 

need a web browsers, such as Netscape Navigator, Microsoft Internet Explorer or Mozilla 

Firefox. 

Currently you must be using any sort of Web browser while you are naviating through my site 

tutorialspoint.com. On the Web, when you navigate through pages of information this is 

commonly known as browsing or surfing. 

7.SMTP SERVER - This stands for Simple Mail Transfer Protocol Server. This server takes 

care of delivering emails from one server to another server. When you send an email to an email 

address, it is delivered to its recipient by a SMTP Server. 
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8.ISP - This stands for Internet Service Provider. They are the companies who provide you 

service in terms of internet connection to connect to the internet.You will buy space on a Web 

Server from any Internet Service Provider. This space will be used to host your Web site. 

9.HTML - This stands for HyperText Markup Language. This is the language in which we write 

web pages for any Website. Even the page you are reading right now is written in HTML.This is 

a subset of Standard Generalized Mark-Up Language (SGML) for electronic publishing, the 

specific standard used for the World Wide Web. 

10. HYPERLINK - A hyperlink or simply a link is a selectable element in an electronic 

document that serves as an access point to other electronic resources. Typically, you click the 

hyperlink to access the linked resource. Familiar hyperlinks include buttons, icons, image maps, 

and clickable text links. 

11.DNS - DNS stands for Domain Name System. When someone types in your domain name, 

www.example.com, your browser will ask the Domain Name System to find the IP that hosts 

your site. When you register your domain name, your IP address should be put in a DNS along 

with your domain name. Without doing it your domain name will not be functioning properly. 

12.W3C - This stands for World Wide Web Consortium which is an international consortium of 

companies involved with the Internet and the Web. The W3C was founded in 1994 by Tim 

Berners-Lee, the original architect of the World Wide Web. The organization's purpose is to 

develop open standards so that the Web evolves in a single direction rather than being splintered 

among competing factions. The W3C is the chief standards body for HTTP and HTML 

 

Applications OF INTERNET 

Internet is today one of the most important part of our daily life. There are large numbers of 

things that can be done using the internet and so it is very important. You can say that with the 

progress in the internet we are progressing in every sphere of life as it not only makes our tasks 

easier but also saves a lot of time. Today internet is used for different purposes depending upon 

the requirement. Here in this very article we have mentioned then ten best uses of the internet. 

Here goes the list. 

 

1. Communication - Communication is the most important gift that the internet has given to the 

common man. Email, social networking sites are some of the prime example of it. This is one 

such gift of the internet which is cherished by everyone and has made our life easier to much 

extent. 

2. Research - Now the point that has been placed next is research. In order to do research you 

need to go through hundreds of books as well as the references and that was one of the most 
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difficult jobs to do earlier. Since the internet came into life, everything is available just a click 

away. And since internet is here to make your research public, you can then benefit a large 

amount of people from the research work that you have done.  

3. Education - The next point that we have in this list is education. Yes you read it right. 

Education is one of the best things that the internet can provide. There are a number of books, 

reference books, online help centers, expert‘s views and other study oriented material on the 

internet that can make the learning process very easier as well as a fun learning experience. 

There are lots and lots of websites which are related to different topic.  

4. Financial Transaction - Now you don‘t need to stand in the queue at the branch of your 

particular bank rather you can just log in on to the bank website with the credential that has been 

provided to you by the bank and then can do any transaction related to finance at your will.  

5. Real Time Updates - Real time updates have been placed at the number fifth position here.. 

There are various websites on the internet which provides you with the real time updates in every 

field be it in business, sports, finance, politics, entertainment and others.  

6. Leisure -Leisure is the option that we have next in the list. Yes you heard it right. Right from 

watching your favorite videos to listening songs, watching movies, playing games, chatting with 

the loved ones has been possible due to internet.. 

 7. Online Booking - Not only the online booking process is easier as well as less tedious but is 

also reliable. There is no need to visit the booking counters to book tickets or to contact the 

agents that might ask for more money in order to process your request. You can do all these 

things sitting at home, using internet.  

 8. Job Search - Job search is one such thing which required updates from every corner as well 

the patience from the person searching for it. Using internet, this has become an easier task. Job 

search has been placed at the number eighth place. There are endless amount of websites on the 

internet that provided with the news about the vacancy in various companies.  

 9. Blogging - There are many people who are very much interested in writing blogs and for 

them internet is the best place. There is huge number of websites over the internet which allows 

you to write blogs. You just need to get yourself registered as per their procedure and then start 

writing.  

 10. Shopping - Shopping has now become one of the most pleasing things to do using the 

internet. Whenever you find time, just visit the concerned websites and order the items that you 

need from there.Those items will be delivered to you in best possible time.  

 

 

Internet browsers: 

Internet browser or web browser are softwares that allow you to explore the net. These 

are actually client programs and are capable to display and interact with hypertext 

document. These softwares  are especially designed for the web use.  
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There are two types of browsers text based browser and graphical browser. Graphical 

browser supports multimedia like text, video, animation, audio etc.  

Some popular browsers are – 

 Microsoft Internet Explorer 

 Mozila Firefox 

 Google Chrome  

 Opera   

 

Microsoft Internet Explorer 

Internet Explorer (IE) is a World Wide Web browser that comes bundled with the Microsoft 

Windows operating system (OS). The browser was deprecated in Windows 10 in favor of 

Microsoft's new Edge Browser. It remains a part of the operating system even though it is no 

longer the default browser 

Mozilla Firefox (or simply Firefox) is a free and open-source web browser developed 

by Mozilla Foundation and its subsidiary,Mozilla Corporation. ... Firefox is the spiritual 

successor of Netscape Navigator, as the Mozilla community was created by Netscape in 1998 

before their acquisition by AOL. 

Google Chrome browser is an open source program for accessing the World Wide Web and 

running Web-based applications. ... Google released Chrome in 2008 and issues several updates 

a year. It is available for Windows, Mac OS X, Linux, Android and iOS operating systems. 

Opera Mini is a web browser designed primarily for mobile phones, smartphones and personal 

digital assistants. Until version 4 it used the Java ME platform, requiring the mobile device to 

run Java ME applications. 

INTERNET SERVICE  PROVIDER (ISP):-  

A company that provides internet access is known as internet service provider. A  ISP charge for 

its services. In general ISPs take two types of fees: 

 A charge for using the internet 

 A charge for a physical connection to the internet 
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Use charges are billed at a fixed rate, ISPs do discriminate among classes of users. An ISP might 

provide dial up access, a cable connection, an ADSL connection or other types of internet access. 

In India there are more than 150 ISPs ( including BSNL, Airtel  , etc) 

Kinds of connection 

Dialup accounts:  this is the slowest kind of connection currently available. Also your telephone 

line stays in use until you terminate the connection, implying that if your telephone bill is 

calculated according to the time of use. 

ISDN(Integrated Service  Digital Network): 

Uses fully digital signals over copper phone wire, a standard telephone line. This means there is 

no conversion from digital to analog and back again in manner that an analog modem works. 

Broadband :   includes serveral transmission technologies, such as digital subscriber 

Line(DSL),cable , wireless ,satellite. 

Domain name systems(DNS): -  

It is an internet engineering task force(IETF) standard name service that allows your computer to 

register and resolve domain names. In other words DNS is a  system that translates domain 

names into IP address. This is  necessary because computers only make use of IP address yet we 

use only readable names since the name are easier to remember than IP address. 

Categories : -  

1. .com    for commercial purpose like www.thinkdigital.com 

2. .edu     for education domains like www.amity.edu 

3. .net      for network, internet service provider and other network related companies like 

www.att.net 

4. .org      for non government organization and non commercial  like www.cry.org 

5. .mil      for the united state military. 

Country level domain: - it is reserve for country. For example .in for India, .uk for united 

kingdom, .pk for Pakistan. 

Introduction to firewall: -  

A firewall is an executable code , the  attacker could compromise that code and execute from the 

firewall device. A firewall is a computer that sits between internal network and  the rest of the 

network and attempts to prevent bad things from happenings 

http://www.thinkdigital.com/
http://www.amity.edu/
http://www.att.net/
http://www.cry.org/
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Firewall uses the following technique to control access and enforce the site‘s security policy: 

1. Service control – determine the types of internet service that can be accessed inbound or 

outbound. 

2. Direction control – decides direction for initiation of service request and allowed to flow 

through the firewall. 

3. User control – controls access to a service ,which user is attempting to access it. 

4. Behavior control – controls how particular services are used. For example the firewall 

may filter e-mail to eliminate spam. 

Types of firewall: - 

1. Packet filtering router 

2. Application gateways 

3. Circuit level gateway 

4. Stateful packet inspection firewalls 

5. Guard  

6. Personal firewall 

 

Pop-up blocker: - a pop-up blocker refers to any software or application that disables any pop –

up , pop over or pop under advertisement window that you would see while using a web browser. 

Some pop up blockers may try to close all pop – up windows ,some may remove all 

advertisement from a publisher‘s web site , an still others may help you choose which popup 

windows you want to be closed with block list feature. 

Virus :-  

A computer virus is a program or piece of code that is loaded onto your computer without you 

knowledge an runs against your wishes. All computer virus are man made. 

A few prominent virus are Michelangelo, dishwasher, C-brain , macmag , nenusalem , columbus  

etc.- 

How a virus spread : 

1. Using a paired device 

2. Through network system 

3. Through secondary storage devices 

4. Through internet 

Types of computer virus : - 
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1. Boot sector virus  - these  types of viruses get themselves stored in th boot sector of 

floopy and hard disk. When we boot a computer system it hinders the loading of 

oprating system. 

2. Partition table virus – these kind of viruses affect the partition table of hard disk but 

do not affect the data in the computer.it only affects MBR(master boot record) of the 

hard disk. 

3. File virus- this kind of virus get associated with executable files. When an EXE file is 

executed , virus may executes to affect the computer system. 

4. Stealth v-irus – a stealth virus is a computer virus that makes every effort to conceal 

its presence from the user. 

5. Polymorphic virus – a polymorphic virus is one that is capable of changing itself so 

that each infection of the virus is completely different from the original. 

6. Macro virus – a macro virus is a virus specially meant to infect specific type of file 

such as document file and spreadsheet file. 

 

Antivirus : - a utility software that searches a hard disk for viruses and removes any that are 

found. Most antivirus programs include an auto update feature that enables the program to 

download profiles of nes virus so that it can check for the new viruses as soon as they are 

discovered. 

Some popular antivirus are NPAV, Quick heal ,Avast and Mac fee etc. 

Email basic :  

Email is a method of exchanging digital messages , designed primarily for human use. A 

message at least consists of its content , an author address and one of more recipient addresses. 

The foundation for today‘s global internet email service was created in the early Arpanet an was 

codified as a  standard  for encoding of messages , as RFC 733.  

Features of email : 

1. Address book 

2. Statistics 

3. Sorting or mails 

4. Security 

5. Edfit/draft option 

6. File attachment 

7. Reply/forward option 

Working of email –  
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Email is based around the use of electronic mailboxes. When an email is sent, the message is 

routed from server to server, all the way to the recipient's email server.the message is sent to the 

mail server tasked with transporting emails (called the MTA, for Mail Transport Agent) to the 

recipient's MTA. On the Internet, MTAs communicate with one another using the protocol 

SMTP, and so are logically called SMTP servers (or sometimes outgoing mail servers).  

The recipient's MTA then delivers the email to the incoming mail server (called the MDA, for 

Mail Delivery Agent), which stores the email as it waits for the user to accept it. There are two 

main protocols used for retrieving email on an MDA:  

POP3 (Post Office Protocol), the older of the two, which is used for retrieving email and, in 

certain cases, leaving a copy of it on the server.  

 IMAP (Internet Message Access Protocol), which is used for coordinating the status of emails 

(read, deleted, moved) across multiple email clients. With IMAP, a copy of every message is 

saved on the server, so that this synchronization task can be completed.  To keep everyone from 

checking other users' emails, MDA is protected by a user name called a login and by a password. 

Retrieving mail is done using a software program called an MUA (Mail User Agent). When the 

MUA is a program installed on the user's system, it is called an email client (such as Mozilla 

Thunderbird, Microsoft Outlook, Eudora Mail, Incredimail or Lotus Notes).  

Types of email –  

1. Marketing Emails : - Marketing (or Bulk) emails stimulate your clients and leads. They 

contain informative / incentive messages. The recipient must agree to receive such 

emails: opt-in is mandatory. 

Examples : - Newsletters , Flash sales , Sales/promotions announcements 

2. Notification Emails:- Notification email are also known as trigger, alert or auto-

responder. They allow the user to be notified each time a particular event happens (or has 

happened). More generally, the notification email may be used in order to celebrate 

and/or mark an event. 

Examples: - getting in touch a few days after registration , Congratulations after a status 

change (first purchase, subscription...) , Birthday email , Shopping Cart Abandonment 

email 

3. Transactional Emails: - This is an expected message and its content is information that 

the client wishes to check or confirm, and not "discover". This type of email is not 

intended to optimize the customer relationship but to define it and mark it out. It is a 

point of reference in one‘s CRM. 

Examples; - Welcome message / Account opening , Shipment tracking and order status , 

Order shipment confirmation , Account termination 
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Free email sites are : -  

www.google.com 

www.yahoo.com 

www.rediff.com 

www.indiatimes.com 

www.mail.com 

www.inbox.com 

 

Simple Mail Transfer Protocol (SMTP) :-  

 

The Simple Mail Transfer Protocol (SMTP) service, which transfers e-mail, is installed as part of 

E-mail Services, along with the POP3 service. 

 

SMTP controls how e-mail is transported and then delivered across the Internet to the destination 

server. The SMTP service sends and receives e-mail between servers, whereas the POP3 service 

retrieves e-mail from the mail server to the user's computer. For more information, see the SMTP 

documentation Microsoft SMTP Service. 

Pop3(post office protocol) : -  the post office protocol is an application layer protocol used by 

local email client s to retrieve email from a remote server over a TCP/IP connection. The POP 

protocol has been developed through several versions. With version 3 being the current standard 

.like IMAP , POP3 is supported by most webmail services such as Hotmail, Gmail And yahoo 

mail. 

Internet security  

Internet security refers to securing communication over the internet. Internet security threats 

impact the network, data security and other internet connected systems. Cyber criminals have 

evolved several techniques to threat privacy and integrity of bank accounts, businesses, and 

organizations. 

Following are some of the internet security threats: 

 Mobile worms 

http://www.google.com/
http://www.yahoo.com/
http://www.rediff.com/
http://www.indiatimes.com/
http://www.mail.com/
http://www.inbox.com/
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 Malware 

 PC and Mobile ransom ware 

 Large scale attacks that attempts to destroy infrastructure. 

 Hacking as a Service 

 Spam 

 Phishing 

Network security 

Network security is any activity designed to protect the usability and integrity of your network 

and data. It includes both hardware and software technologies. Effective network security 

manages access to the network. It targets a variety of threats and stops them from entering or 

spreading on your network. 

How does network security work? 

Network security combines multiple layers of defenses at the edge and in the network. Each 

network security layer implements policies and controls. Authorized users gain access to 

network resources, but malicious actors is blocked from carrying out exploits and threats. 

Types of network security 

 Access control 

 Antivirus and antimalware software 

 Application security 

 Behavioral analytics 

 Data loss prevention 

 Email security 

 Firewalls 

 Intrusion prevention systems 

Passwords 

Passwords are the first line of defense against cyber criminals. Hackers have many different 

ways of attempting to gain access to accounts, but your ability to avoid an attack is highly 

dependent on the strength of your password. Password contains lowercase and uppercase 

alphabetic characters, numbers and symbols also if permitted. the strength of a password is a 

function of length, complexity, and unpredictability. 

Cryptography 
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Cryptography is a cornerstone of the modern electronic security technologies used today to 

protect valuable information resources on intranets, extranets, and the Internet. 

Digital signature 

A digital signature (not to be confused with a digital certificate) is a mathematical technique used 

to validate the authenticity and integrity of a message, software or digital document. 

The digital equivalent of a handwritten signature or stamped seal, but offering far more inherent 

security, a digital signature is intended to solve the problem of tampering and impersonation in 

digital communications. Digital signatures can provide the added assurances of evidence to 

origin, identity and status of an electronic document, transaction or message, as well as 

acknowledging informed consent by the signer. 

 

Digital certificate  

A digital certificate is an electronic "passport" that allows a person, computer or organization to 

exchange information securely over the Internet using the public key infrastructure (PKI). A 

digital certificate may also be referred to as a public key certificate. 

An attachment to an electronic message used for security purposes. The most common use of 

a digital certificate is to verify that a user sending a message is who he or she claims to be, and to 

provide the receiver with the means to encode a reply. 

Just like a passport, a digital certificate provides identifying information is forgery resistant and 

can be verified because it was issued by an official, trusted agency. The certificate contains the 



 
 
 
 
 
 

 
45, Anurag Nagar, Behind Press Complex, Indore (M.P.) Ph.: 4262100, www.rccmindore.com 

115 
 

name of the certificate holder, a serial number, expiration dates, a copy of the certificate holder's 

public key (used for encrypting messages and digital signatures) and the digital signature of the 

certificate-issuing authority (CA) so that a recipient can verify that the certificate is real. 

Biometric security 

The term biometrics is derived from the Greek words bio meaning life and metric meaning to 

measure.it is a security mechanism used to authenticate and provide access to a facility or 

system based on the automatic and instant verification of an individual's physical and behavioral 

characteristics. The technology is mainly used for identification and access control, or for 

identifying individuals who are under surveillance. 

The two main types of biometric identifiers depend on either physiological characteristics or 

behavioral characteristics. 

Physiological identifiers relate to the composition of the user being authenticated and include 

facial recognition, fingerprints, finger geometry (the size and position of fingers), iris 

recognition, vein recognition, retina scanning, voice recognition and DNA matching. 

Behavioral identifiers include the unique ways in which individuals act, including recognition of 

typing patterns, walking gait and other gestures. Some of these behavioral identifiers can be used 

to provide continuous authentication instead of a single one-off authentication check. 

An individual's body characteristics are pre-stored in a biometric security system or scanner, 

which may be accessed by authorized personnel. When an individual walks into a facility or tries 

to gain access to a system, the biometric scanner evaluates his/her physical characteristics, which 

are matched with stored records. If a match is located, the individual is granted access 

Telnet 

Telnet is a protocol used to log in to remote computer on the internet. There are a number of 

Telnet clients having user friendly user interface. The following diagram shows a person is 

logged in to computer A, and from there, he remote logged into computer B. 



 
 
 
 
 
 

 
45, Anurag Nagar, Behind Press Complex, Indore (M.P.) Ph.: 4262100, www.rccmindore.com 

116 
 

 
 

 

Intranet 

An intranet is a private network that is contained within an enterprise. It may consist of many 

interlinked local area networks and also use leased lines in the wide area network. Typically, an 

intranet includes connections through one or more gateway computers to the outside Internet. 

The main purpose of an intranet is  

 to share company information and computing resources among employees.  

 An intranet can also be used to facilitate working in groups and for teleconferences. 

 companies can send private messages through the public network 

Extranet 

An extranet is a private network that uses Internet technology and the public telecommunication 

system to securely share part of a business's information or operations with suppliers, vendors, 

partners, customers, or other businesses. An extranet can be viewed as part of a company's 

intranet that is extended to users outside the company. It has also been described as a "state of 

mind" in which the Internet is perceived as a way to do business with other companies as well as 

to sell products to customers. 

Companies can use an extranet to: 

 

 Exchange large volumes of data using Electronic Data Interchange (EDI) 

 Share product catalogs exclusively with wholesalers or those "in the trade" 

 Collaborate with other companies on joint development efforts 

 Jointly develop and use training programs with other companies 

 Provide or access services provided by one company to a group of other companies, such 

as an online banking application managed by one company on behalf of affiliated banks 

 Share news of common interest exclusively with partner companies 
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E-ticket (electronic ticket) 

An e-ticket (electronic ticket) is a paperless electronic document used for ticketing 

passengers, particularly in the different commercial industries. Virtually all major industries 

(like movies, railways and airlines etc. ) now use this method of e-ticketing. 

Example:. When a customer books a flight by telephone or using the Web, the details of the 

reservation are stored in a computer. The customer can request that a hardcopy confirmation 

be sent by postal mail, but it is not needed at the check-in desk. A confirmation number is 

assigned to the passenger, along with the flight number(s), date(s), departure location(s), and 

destination location(s). When checking in at the airport, the passenger simply presents 

positive identification. Then necessary boarding passes are issued, and the passenger can 

check luggage and proceed through security to the gate area. 

The principal advantage of e-ticketing is the fact that  

 It reduces booking expense by eliminating the need for printing and mailing paper 

documents.  

 Another advantage is that it eliminates the possibility of critical documents getting 

lost in the mail or being sent to the wrong address. 

Chatting 

Chat refers to the process of communicating, interacting and/or exchanging messages over the 

Internet. It involves two or more individuals that communicate through a chat-enabled service or 

software. It is a text-based communication that is live or in real-time. 

Chat is also known as chatting, online chat or Internet chat. 

Chat may be delivered through text, verbal, audio, visual or audio-visual (A/V) communication 

via the Internet. If conducted through a desktop, chat requires software that supports Internet 

Relay Chat (IRC) or an instant messenger application, where a central server manages chat 

communication between different end user clients. 

There are also online chat services that require users to sign up with a valid email address. After 

signing up, a user may join a group chat room or send a private message to another individual. 

Online chat services have purpose-built chat interfaces that manage the entire communication 

processes 

E-banking 
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E-banking, includes any transaction is performed using the Internet or a mobile device. Making 

electronic payments, paying bills and transferring money between accounts are all elements of e-

banking, which can be done from your cell phone or computer. Despite potential risks of identity 

theft and account hacking and less personal contact with the bank, e-banking presents a number 

of advantages to customers as well as to banks also.. 

 Convenience 

 Saves time 

 Portability 
 Cost Savings 

 Track Spending 

 Industry Benefits 

 No paper bills and pile of papers 

 Efficiency 

 

Types of E banking 

 Information Only System 

 Electronic Information Transfer System 

 Fully Electronic System 

VARIOUS FORMS OF E-BANKING: 

 INTERNET BANKING: Internet Banking helps you manage many banking 

transactions online via your PC. 

 AUTOMATED TELLER MACHINES (ATM): ... 

An automated teller machine or automatic teller machine (ATM) is an electronic 

computerized telecommunications device that allows a financial institution's 

customers to directly use a secure method of communication to access their bank 

accounts, order or make cash withdrawals (or cash advances using a credit card) and 

check their account balances without the need for a human bank teller. 

 TELE BANKING: ... 

By dialing the given Telebanking number through a landline or a mobile from 

anywhere, the customer can access his account and by following the user-friendly 

menu, entire banking can be done through Interactive Voice Response (IVR) system 

 SMART CARD: ... 
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A smart card usually contains an embedded 8-bit microprocessor (a kind of computer 

chip). The microprocessor is under a contact pad on one side of the card. Think of the 

microprocessor as replacing the usual magnetic stripe present on a credit card or debit 

card. 

The microprocessor on the smart card is there for security. The host computer and 

card reader actually "talk" to the microprocessor. The microprocessor enforces access 

to the data on the card. The chips in these cards are capable of many kinds of 

transactions. 

 

 DEBIT CARD: .. 

Debit cards are also known as check cards. Debit cards look like credit cards or ATM 

(automated teller machine) cards, but operate like cash or a personal check. Debit 

cards are different from credit cards. While a credit card is a way to "pay later," a 

debit card is a way to "pay now." When you use a debit card, your money is quickly 

deducted from your checking or savings account.. 

 E-CHEQUE: ... 

An e-Cheque is the electronic version or representation of paper cheque. 

 

ELECTRONIC PAYMENT SYSTEM 

 Electronic payment systems are proliferating in banking, retail, health care, 

on-line markets, and even government—in fact, anywhere money needs to change 

hands. 

 Organizations are motivated by the need to deliver products and services 

more cost effectively and to provide a higher quality of service to customers. 

 The emerging electronic payment technology labeled electronic funds transfer (EFT). 

 EFT is defined as ―any transfer of funds initiated through an electronic 

terminal, telephonic instrument, or computer or magnetic tape so as to order, 

instruct, or authorize a financial institution 

EFT can be segmented into three broad categories: 

 

1. Banking and financial payments 

– Large-scale or wholesale payments (e.g., bank-to-bank transfer) 
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– Small-scale or retail payments (e.g., automated teller machines) 

– Home banking (e.g., bill payment) 

 

2. Retailing payments 

– Credit Cards (e.g., VISA or MasterCard) 

– Private label credit/debit cards (e.g., J.C. Penney Card) 

– Charge Cards (e.g., American Express 

 

3. On-line electronic commerce payments 

3.1. Token-based payment systems 

 

o Electronic cash (e.g., DigiCash) 

o Electronic checks (e.g., NetCheque) 

o Smart cards or debit cards (e.g., Mondex Electronic Currency Card)) 

 

3.2. Credit card-based payments systems 

 

o Encrypted Credit Cards (e.g., World Wide Web form-based encryption) 

o Third-party authorization numbers (e.g., First Virtual) 

 

3.1) DIGITAL TOKEN-BASED ELECTRONIC PAYMENT SYSTEMS 

Electronic tokens are three types: 

1. Cash or Real-time 

o Transactions are settled with exchange of electronic currency. 

o Ex: on-line currency exchange is electronic cash (e-cash). 

2. Debit or Prepaid 

o Users pay in advance for the privilege of getting information. 

o Ex: prepaid payment mechanisms are stored in smart cards and electronic 

purses that store electronic money. 

3. Credit or Postpaid 

o The server authenticates the customers and verifies with the bank that funds are 

adequate before purchase. 

o Ex: postpaid mechanisms are credit/debit cards and electronic checks. 

4. Properties of Electronic Cash: 

o There are many ways that exist for implementing an e-cash system, all must 
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incorporate a few common features. 

o Specifically,  

e-cash must have the following four properties: 

1. Monetary value 

2. Interoperability 

3. Retrievability 

4. Security 

Electronic Cash in Action 

o Electronic Cash is based on cryptographic systems called ―digital signatures‖. 

o This method involves a pair of numeric keys: one for locking (encoding) and the other 

for unlocking (decoding). (Through public key and private key). 

Purchasing E-cash from Currency Servers 

The purchase of e-cash from an on-line currency server (or bank) involves two steps: 

 Establishment of an account and maintaining enough money in the account to bank the 

purchase. Some customers might prefer to purchase e-cash with paper currency, 

either to maintain anonymity or because they don‘t have a bank account. 

 

Using the Digital Currency 

· Once the tokens are purchased, the e-cash software on the customer‘s PC stores 

digital money undersigned by a bank. 

· The users can spend the digital money at any shop accepting e-cash, without 

having to open an account there or having to transmit credit card numbers. 

· As soon as the customer wants to make a payment, the software collects the 

necessary amount from the stored tokens. 
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Electronic Checks 

· It is another form of electronic tokens. 

· In the given model shown in fig, buyers must register with third-party account 

server before they are able to write electronic checks. 

· The account server acts as a billing service. 

· The advantages are: 

1. They work in the same way as traditional checks. 

2. These are suited for clearing micropayments 

3. They create float & availability of float is an important for commerce 

4. Financial risk is assumed by the accounting server & may result in easier acceptance 

 

 

 

 

 

 

 

 

Smart Cards & Electronic Payment Systems 

 

· Smart cards have been in existence since the early 1980s and hold promise for 

secure transactions using existing infrastructure. 

· Smart cards are credit and debit cards and other card products enhanced 
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with microprocessors capable of holding more information than the traditional 

magnetic stripe. 

· The smart card technology is widely used in countries such as France, Germany, 

Japan, and Singapore to pay for public phone calls, transportation, and 

shopper loyalty programs. 

Smart cards are basically two types: 

– Relationship-Based Smart Credit Cards 

– Electronic Purses, which replace money, are also known as debit 

cards and electronic money. 

Relationship-Based Smart Credit Cards 

–  It is an enhancement of existing cards services &/ or the addition of new 

services that a financial institution delivers to its customers via a chip-

based card or other device 

– These services include access to multiple financial accounts, value-

added marketing programs, or other information card holders may want to 

store on their card 

– It includes access to multiple accounts, such as debit, credit, cash 

access, bill payment & multiple access options at multiple locations 

 

Electronic Purses 

· To replace cash and place a financial instrument are racing to introduce 

―electronic purses‖, wallet-sized smart cards embedded with programmable 

microchips that store sums of money for people to use instead of cash for 

everything 

· The electronic purse works in the following manner: 

1. After purse is loaded with money at an ATM, it can be used to pay for candy in a 

vending machine with a card reader. 
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2. It verifies card is authentic & it has enough money, the value is deducted from 

balance on the card & added to an e-cash & remaining balance is displayed by the 

vending machine. 

 

3. 2) CREDIT CARD-BASED ELECTRONIC PAYMENT SYSTEMS 

Payment cards are all types of plastic cards that consumers use to make purchases: 

– Credit cards 

· Such as a Visa or a MasterCard, has a preset spending limit based on the user‘s 

credit limit. 

– Debit cards 

· Removes the amount of the charge from the cardholder‘s account and transfers it 

to the seller‘s bank. 

– Charge cards 

· Such as one from American Express, carries no preset spending limit. 

Advantages: 

– Payment cards provide fraud protection. 

– They have worldwide acceptance (nearly!). 

– They are good for online transactions. 

 

Disadvantages: 

– Payment card service companies charge merchants per-transaction fees and 

monthly processing fees. 

 



 
 
 
 
 
 

 
45, Anurag Nagar, Behind Press Complex, Indore (M.P.) Ph.: 4262100, www.rccmindore.com 

125 
 

Payment Acceptance and Processing 

·  Open loop (such as VISA) and closed loop (such as American Express) 

systems will accept and process payment cards. 

·  A merchant bank or acquiring bank is a bank that does business with 

merchants who want to accept payment cards. 

 

·  Software packaged with your electronic commerce software can handle 

payment card processing automatically. 

 

 

 

 

 

 

 

 

· Electronic cash is a general term that describes the attempts of several 

companies to create value storage and exchange system that operates online in 

much the same way that government-issued currency operates in the physical 

world. 

· Concerns about electronic payment methods include: 

– Privacy 

– Security 

– Independence 

– Portability 

– Convenience 
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Electronic Cash Issues 

· Primary advantage is with purchase of items less than £5 

· Credit card transaction fees make small purchases unprofitable 

· Facilitates Micropayments – eg for items costing less than £1 

· Must be anonymous, just like regular currency 

· Safeguards must be in place to prevent counterfeiting 

·  Must be independent and freely transferable regardless of nationality or 

storage mechanism 

Electronic Cash Storage 

· Two methods 

– On-line 

· Individual does not have possession personally of electronic cash 

· Trusted third party, e.g. e-banking, bank holds customers‘ cash accounts 

– Off-line 

· Customer holds cash on smart card or electronic wallet 

· Fraud and double spending require tamper-proof encryption 

Risks in Electronic Payment systems 

· Customer's risks 

– Stolen credentials or password 

– Dishonest merchant 

– Disputes over transaction 

– Inappropriate use of transaction details 

· Merchant‘s risk 

– Forged or copied instruments 

– Disputed charges 

– Insufficient funds in customer‘s account 

– Unauthorized redistribution of purchased items 

· Main issue: Secure payment scheme 
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Electronic payments Issues 

· Secure transfer across internet 

· High reliability: no single failure point 

· Atomic transactions 

· Anonymity of buyer 

· Economic and computational efficiency: allow micropayments 

·  Scalability in number of servers and users 

Designing Electronic Payment systems 

It includes several factors: 

· Privacy. A user expects to trust in a secure system; just as a telephone is a safe 

· Security. A secure system verifies the identity of two-party transactions through 

―user authentication‖ & reserves flexibility to restrict information/services 

through access control 

· Intuitive interfaces. The payment interface must be as easy to use as a telephone. 

·  Database integration. With home banking, for ex, a customer wants to play with 

all his accounts. 

·  Brokers. A ―network banker‖-someone to broker goods & services, settle 

conflicts, & ‗financial transactions electronically-must be in place 

· Pricing. One fundamental issue is how to price payment system services. For 

e.g., from cash to bank payments, from paper-based to e-cash. The problem is 

potential waste of resources. 

·  Standards. Without standards, the welding of different payment users into 

different networks & different systems is impossible. 

E-Cash or Electronic cash 

E-Cash or Electronic Cash is a new concept to execute cash payment using computers 

connected with network. E-cash is an electronic medium for making payments. The primary 

function of e-cash is to facilitate transactions on the Internet. Many of these transactions may be 

small in size and would not be cost efficient through other payment medium such as credit 

cards. 
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Electronic money [also known as e-currency, e-money, electronic cash, electronic currency, 

digital money, digital cash or digital currency] refers to money or scrip which is exchanged only 

electronically. Typically, this involves the use of computer networks, the internet and digital 

stored value systems. Electronic Fund Transfer and direct Deposit are all examples of electronic 

money. 

E-cash is a system of purchasing cash credits in relatively small amounts, storing the credits in 

our computer, and then spending them when making electronic purchases over the Internet. The 

e-cash is the creation of electronic money or tokens, usually by a bank, which buyers and sellers 

trade for goods and services. It consists of a token, which may be authenticated independently of 

the issuer. This is commonly achieved through the use of self-authenticating tokens or tamper 

proof hardware. It includes credit cards, smart cards, debit cards, electronic fund transfer etc. 

An e-cash system must have the following properties:-  

 Digital cash must have a monetary value. It must be backed by cash  

 Digital cash must be exchangeable.  

  It should be storable and retrievable  

 It should not be easy to copy or tamper with while it is being exchanged 

E-cash can be used for making or receiving payments between buyer and seller. The bank‘s 

server computer sends a secure e-cash packet to the customer effect the network currency server 

of the bank is issuing a bank note with a serial number for a specified amount. The bank uses its 

private key to digitally sign such a bank note 

E-brokerage  

An e-brokerage is a brokerage house that allows you to buy and sell stocks and obtain 

investment information from its Web site. Some e-brokerages are provided by traditional and 

well-established "offline" brokerage houses and a few are exclusively online only. Almost all e-

brokerage houses have simple sign-up and provide users the ability to make them their own 

financial manager. E-brokerage industry enables investors to use the Internet to conduct secure 

trading.  

Two factors are contributing to the enormous growth of online investing.  

 First, the Internet gives ready access to raw data.  

 Second, investment houses can offer transactions at lower prices than traditional 
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methods by eliminating the need for brokers or financial advisers. 

E-brokerage has many benefits for its users.  

 Users can have more flexibility as well as control over their portfolios and transactions.  

 One can access their brokerage account at any time, even if trading hours are over. 

 The commission cost is significantly lower than in case of services of a professional 

broker.  

 Trades are processed quickly in e-brokerage and there are no delays, unlike traditional 

brokerage methods. 

Disadvantages of E-brokerage 

 Unlike traditional brokerage, the mentoring relationship between the account holder and 

professional broker is not there.  

 All financial choices must be made by the user.  

 The level of service is less than with traditional brokerages. 

E-Commerce Models 

E-Commerce is a much wider subject than selling online. It is of the view that e-commerce 

covers any form of transaction where technology has played a part. There are also many different 

types of e-commerce, with differing relationships existing with each.  

Some of the important models of e-commerce are as follows:-  

1. Business to Business [B2B] B2B (business – to- business) is the major and valuable model of 

e- commerce.B2B (business – to- business) e-commerce is conducted between two separate 

businesses and has been in effect for many years. E-commerce plays an important role in 

enhancing and transforming relationships between and among business. B2B (business – to- 

business)is also known as e-biz, is the exchange of products, services, or information between 

businesses rather than between businesses and consumers. Although early interest centered on 

the growth of retailing on the Internet (sometimes called e-tailing), forecasts are that B2B 

revenue will far exceed business to consumers [B2C] revenue in the near future. B2B (business – 

to- business) is a kind of e-commerce, which refers to a company selling or buying from other 

companies. One company communicates with other companies through electronic Medias. Some 

of these transactions include sending and receiving orders, invoice and shopping orders. It was an 

attractive alternative to the current process of printing, mailing various business documents. 
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Some B2B applications are the following:-  

1. Supplier Management 

2. Inventory Management 

3. Distribution Management  

4. Channel Management 

5. Payment Management 

Business – to Consumer [B2C]  

Business – to Consumer [B2C] e-commerce consists of the sale of products or services from a 

business to the general public. Products can be anything from clothing to flowers and the 

products can also be intangible products such as online banking, stock trading, and airline 

reservations. Sellers that use B2C business model can increase their benefits by eliminating the 

middlemen. This is called disintermediation because businesses sell products directly to 

consumers without using traditional retail channels. Business – to Consumer [B2C] is basically a 

concept of online marketing and distributing of products and services over the internet. It is a 

natural progression for many retailers or marketer who sells directly to the consumer. The 

general idea is, if you could reach more customers, service them better, make more sales while 

spending less to do it that would the formula of success for implementing a B2C e-commerce 

infrastructure. 

Business – to –Government [B2G] e-commerce 

B2G refers to the supply of goods and services for online government procurement. This is a 

huge market which mainly covers everything from office supplies to military equipment.B2G 

websites offer lower costs and greater choice to the administration, and make government 

tendered offers more accessible to companies.B2G is a derivative of B2B marketing and often 

referred to as a market definition of public sector marketing which encompasses marketing 

products and services to various government levels including-federal, state and local- through 

integrated marketing communications techniques using as strategic public relations, branding, , 

advertising, and web based communications. 

Business- to- employee [B2E] 

Business- to- employee [B2E] uses an intra-business network which allows companies to provide 

products and/ or services to their employees. It is the use of intranet technologies to handle 

activities that take place within a business. An intranet is an internal network that used Internet 
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technologies. Business- to- employee [B2E] is different from other type since it is not a revenue 

form of business. Otherwise, it increases profits by reducing expenses within a company. Instead 

of having to look everything up manually they can collaborate with each other and exchange data 

and other information. Many companies have found that B2E technologies have dramatically 

reduced the administrative burdens with the human resources department. Admittedly, 

maintaining employee information has little to do with commerce, but this term has grown to 

encapsulate this activity into the B2E definition. Examples of B2E applications include 

 Online insurance policy management 

 Corporate announcement dissemination 

 Online supply requests 

 Special employee offers 

 Employee benefits reporting 

Consumer To Consumer (C2C)(Information Service Model) 

Consumer to consumer (C2C) or citizen-to-citizen electronic commerce involves the 

electronically facilitated transactions between consumers through some third party. A common 

example is the online auction, in which a consumer posts an item for sale and other consumers 

bid to purchase it; the third party generally charges a flat fee or commission. 

The sites are only intermediaries, just there to match consumers. They do not have to check 

quality of the products being offered. 

The C2C model facilitates online transactions of goods and services between the individual net 

users. But in this both the web users and both the parties cannot carry out any transaction without 

the platform that is provided by an online market maker such as the eBay. 

There is also the Customer to Business (C2B) model which is relatively less common. It's a 

complete reversal of the traditional sense of transaction, but could be found in crowdsourcing 

based projects. 

A business model describes the rationale of how an organization creates, delivers, and captures 

value in economic, social, cultural or other contexts. 

A business model is an "abstract representation of a business, be it conceptual, textual, and/or 

graphical, of all core interrelated architectural, co-operational, and financial arrangements 

designed and developed by an organization presently and in the future, as well as all core 

products and/or services the organization offers, or will offer, based on these arrangements that 



 
 
 
 
 
 

 
45, Anurag Nagar, Behind Press Complex, Indore (M.P.) Ph.: 4262100, www.rccmindore.com 

132 
 

are needed to achieve its strategic goals and objectives 

Do it yourself (DIY) is the method of building, modifying, or repairing things without the direct 

aid of experts or professionals. Academic research describes DIY as behaviors where 

"individuals engage raw and semi-raw materials and component parts to produce, transform, or 

reconstruct material possessions, including those drawn from the natural environment (e.g. 

landscaping)". DIY behavior can be triggered by various motivations previously categorized as 

marketplace motivations (economic benefits, lack of product availability, lack of product 

quality, need for customization), and identity enhancement (craftsmanship, empowerment, 

community seeking, uniqueness) 

Made to order (MTO) and sometimes referred to as make to order or Build to order (BTO), is 

a production approach where products are not built until a confirmed order for products is 

received. BTO is the oldest style of order fulfillment and is the most appropriate approach used 

for highly customized or low volume products. 

"Made to order" products are common in the food service industry, such as at restaurants. 

This approach is considered good for highly configured products, e.g. automobiles bicycles, 

computer servers, or for products where holding inventories is very expensive, e.g. aircraft 

 


